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Warranty Registration 
 

Please complete the enclosed Warranty Registration Card and send 
it to Lasergraphics.  Warranty registration enables us to keep you 
informed of new developments for MacRascol. 
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About this Guide 
 

This guide explains how to set up and use the MacRascol™ software.  
The guide assumes that you already know how to use a Macintosh.  
If you are new to the Macintosh, review your Macintosh Owner’s 
Guide before proceeding. 
 
 
This guide is organized into two parts. Reading the first part will give 
you a good understanding of the software and how to use it. The first 
chapter, “Introduction,” describes MacRascol features and explains 
important concepts about high-resolution output. “Installation” 
explains how to install the MacRascol software. “Learning 
MacRascol” is a step-by-step tutorial on how to produce your first 
images. “Using MacRascol” describes specific tasks that you can 
perform with MacRascol and provides guidelines on how to treat 
specific types of images. 
 
You can refer to the second part of this guide later when you have 
specific questions or problems. “MacRascol Chooser Driver 
Reference” describes the windows and commands of the MacRascol 
Chooser drivers: SCSI LFR, AppleTalk LFR, LFR Server, and BLL 
File. “MacRascol Quick Print Reference” describes MacRascol 
Quick Print windows, menus, and commands. “MacRascol Queue 
Builder Reference” describes MacRascol Queue Builder windows, 
menus, and commands. “MacRascol Print Monitor Reference” 
describes the MacRascol Print Monitor window, menus, and 
commands. “MacRascol Server Reference” describes the 
MacRascol Server window, menus, and commands. “Appendices” 
describe specifications, how to get Lasergraphics Language (LL) 
images onto the Macintosh, how to speed up processing, and 
troubleshooting procedures. “Glossary” defines terms used in this 
guide. 
 
 
Screen illustrations in this guide are meant to be representative, not 
necessarily exact duplicates of screens that appear on your video 
monitor. 
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Introduction 
 

 
This chapter describes MacRascol features and explains important 
concepts about high-resolution output.   
 
The first section describes MacRascol features. 
 
“Important Concepts” explains how resolution, color fidelity, and 
bitmaps impact your output.   
 
“How Image Queues Work” outlines the basic steps for working 
with image queues to produce high-resolution images. 
 
“MacRascol on a Network” shows how a film recorder can be 
shared on a local area network. 
 
“What You Need” lists required hardware and software. 
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Features 
 

MacRascol™ adds a new dimension to all your visual communications 
by letting you produce professional-quality presentation graphics—
right at your desk. 
 
MacRascol takes images produced by a graphics application and 
outputs them on a film recorder. With a film recorder, you can 
produce 35mm slides, 35mm prints, Polaroid prints, or 120/220 or 
4x5 film transparencies. 
 
MacRascol consists of four Chooser level device drivers and four 
applications.   
 
SCSI LFR is the MacRascol Chooser driver, which lets you print 
images from an application using the Print command. It 
communicates with the film recorder connected to your Macintosh 
SCSI bus. 
 
AppleTalk LFR is the driver that communicates with the film recorder 
connected to your AppleTalk network. 
 
LFR Server is the driver that communicates with the MacRascol 
Server application across the AppleTalk network. 
 
BLL File is the driver that converts printed images to BLL files for 
imaging by other Lasergraphics software at another station. 
 
MacRascol Quick Print lets you print images of many different file 
formats with an LFR driver. 
 
MacRascol Queue Builder lets you organize images into groups 
called queues and enhance the images for processing as high-
resolution color output.   
 
MacRascol Print Monitor processes images in your queues and 
outputs them on the film recorder or as BLL files. 
 
MacRascol Server makes it possible to run the MacRascol software 
over an AppleTalk network in order to share your LFR between many 
Macintosh users. 
 
With any Lasergraphics Film Recorder (LFR™), MacRascol 
produces brilliant color images on film. The resolution of 4000 lines 
produces sharp images with over 36 times the image resolution 
(total number of dots in an image) of a common Macintosh screen. 
The 8000 and 16000 line resolutions available with some film 
recorders are excellent for large film sizes.  

 

L A S E R G R A P H I C S

   
    LFR Slides            or Prints 
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Support for 24-bit color enables you to produce life-like pictures 
with any of over 16.7 million colors.  24-bit color refers to the way 
color information is stored in the image.  24-bit color is sometimes 
called “true color” because it reproduces the full range of color 
visible to the human eye. 
 
In addition to producing sharp, colorful images, MacRascol is fast.  
Most images are processed in less than a minute.  With this kind of 
performance, MacRascol has the capacity to serve as a high-
volume production tool for corporations and service bureaus. 

 
 
MacRascol is compatible with any Macintosh graphics application 
that supports PICT.  PICT is the standard format for Macintosh 
graphics.   Some applications may not support PICT, but 
MacRascol is also compatible with any application that can print 
using a MacRascol Chooser driver. You can process images from 
any Macintosh graphics application that can: 
 
! Print to a Chooser driver using the Print command. 

! Place a series of PICT images in a Scrapbook 

! Save files in PICT format 

! Copy a PICT image to the Clipboard 

! Drag a PICT format clipping 

 
MacRascol also processes images stored in Lasergraphics 
Language (LL), a popular format for producing graphics on IBM® 
PCs and compatibles, minicomputers, and mainframes.  You can 
transfer LL images onto your Macintosh via disk, network, or modem 
and output them through MacRascol. 
 
MacRascol processes images stored in Hewlett-Packard Graphics 
Language (HPGL), a popular format for computer design and 
drafting programs. 
 
MacRascol is compatible with many of the popular raster graphics 
file formats. You can process images from any graphics application 
that uses: 
 
! Targa file format  (.TGA) 

! TIFF™ file format  (.TIF) 

! Adobe Photoshop™ 2.0 file format  

! Adobe Photoshop™ 2.5 (and later) file format  (.PSD) 

! Dicomed Tile file format 

MacRascol and WinRascol (for Windows) software also use a file 
format called Binary Lasergraphics Language, or BLL. A BLL file is 
a platform independent Lasergraphics print file.  It contains all the 
necessary information, including fonts, color correction information, 
and slide quality settings, that is needed to produce an image on a 
Lasergraphics output device.  It can be used on any Macintosh or PC 
to produce images.  It does not matter what machine the BLL file was 
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created on.  The purpose of BLL generator software is to produce 
BLL files from original artwork at a remote site.  The files can then be 
moved to another site for imaging on the output device.  BLL files are 
DOS compatible, so that they may be transferred to a PC via a DOS 
formatted diskette or via a computer network with both Macintoshes 
and PCs. BLL files offer a convenient way for sites to handle images 
from both Macintoshes and PC’s with only one output device. 
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MacRascol enhancement tools let you: 
 
! Print images into queues.  You can easily add images to 

queues by selecting a MacRascol driver from the Chooser and 
using the Page Setup and Print commands from your 
application. 

 
! Group images into queues.  By grouping images into queues, 

you can save complete presentations and easily reproduce 
them at a moment’s notice.  

 
! Crop images.  You can zoom in or out on an image and crop it 

so that just the important part is output. 

 
! Adjust the color balance and gamma values.  You can 

optimize the values for each image individually. 

 
! Add background color to your images.  You can use any of 

16.7 million solid colors as a background behind your image. 

 
! Create a library of standard enhancement settings.  These 

standard settings are called preferences.  Preferences save 
time and effort by letting you change enhancement settings with 
a single mouse click.  For example, you can completely prepare 
an image by applying a preference. 
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Important Concepts 
 

This section explains resolution, color fidelity, and the differences 
between bitmaps and objects. 
 
 

 

Resolution Resolution can be defined in many ways.  Dots per inch (DPI) are 
commonly used, but they are impractical for slides and overhead 
transparencies because the DPI changes significantly when the 
image is projected.  
 
The most practical definition of resolution is the total number of dots 
in the image.  The following table compares the image resolution of 
several Macintosh graphics output devices. 
 
 Device Dots Image Resolution 

Macintosh SE screen 512 by 342 175,104 

Typical 13" screen 640 by 480 307,200 

Most laser printers 2400 by 3276 7,862,400 

LFR film recorder 4096 by 2731 11,186,176 
 
 
Images produced by the LFR contain over 36 times more dots than 
images on a typical 13" screen.  
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When discussing film recorder resolution, the terms "2000-line slide", 
"4000-line slide", or "8000-line slide" are commonly used.  The 
number of lines refers to the number of dots across the image. 
 

2000 Lines

2048 Dots

15
36

 D
ot

s

 

4000 Lines

4096 Dots

27
31

 D
ot

s

 
   

 

Color Fidelity Color fidelity refers to the range of colors that can be reproduced in 
an image. 

 
The number of bits per pixel used to store an image defines the 
range of colors that can be represented.  The more bits per pixel, the 
greater the range of colors.   
 
MacRascol supports 24 bits per pixel, 8 for each of red, green, and 
blue.  This results in 256 shades of each primary color, which can 
combine to form 16.7 million colors.  Each pixel in an image can be a 
different color. 
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Bitmaps and Objects Most PICT images contain either bitmaps or objects, but some 
images contain both.  Bitmaps consist of dots.  Objects consist of 
mathematical descriptions of a shape.  Bitmaps are created in 
“paint” programs, by scanning a photograph, or by making a screen 
capture. Objects are created in “draw” programs. Both graphics and 
text can be a bitmap or an object. 
 
 
Graphics  

Objects become sharper at high resolution.  Bitmaps don’t look any 
worse at high resolution, but they don’t improve either. 
 
At low resolution: 
 
   Bitmaps look jagged   
 
   Objects look jagged   
 
At high resolution: 
 
   Bitmaps remain jagged   
 
   Objects become sharper 
 
You can usually tell bitmaps from objects by watching how the image 
is created when it is first displayed on the screen.  Bitmaps are drawn 
on the screen from top to bottom.  Objects are assembled in pieces.   
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Text 

Text can be constructed with bitmaps or objects, just as a graphic 
can. Text that is part of a bitmapped graphic remains jagged at high 
resolution.  However, text that is an object may become sharper 
when output at high resolution. 
 
All Macintosh text is displayed on the screen using bitmapped screen 
fonts unless you have ATM or TrueType fonts, which are scalable 
fonts for screen display. Scalable fonts are sharp at any size and 
resolution. 

A         
Scalable Font        Bitmapped Font 

 
! NOTE:  Don’t be confused by the fact that object text is 
represented on the screen with a bitmapped font.  What matters is 
how the text is stored in the image, not how it is displayed. 
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How Image Queues Work 
 

Producing graphics output using image queues is a simple three-step 
process.   
 

1 Create your presentation images with a graphics application. Once 
you have done this, you can do any of the following: 
 
! Save the images as PICT, Targa, TIFF, Photoshop, or Dicomed 

Tile files. 

! Put the images in a Scrapbook. 

! Copy single images onto the Clipboard. 

! Drag single images out of the application window to create a 
PICT clipping. 

! Print the images into a queue using the Print command of your 
application with a MacRascol Chooser driver.  This option can 
eliminate step 2. 

2 Group your images into a list called an image queue with 
MacRascol Queue Builder.  If you like, you can enhance the images 
for better reproduction at high resolution. 
 

3 Process the images for output onto the LFR using MacRascol Print 
Monitor.  You can do this whenever it is convenient. 
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At first, you may choose to just “print” an image directly to the LFR.  
But the three-step approach often works better than direct printing for 
the following reasons: 
 
! Since you don’t wait for images to print, you can keep the 

creative juices flowing while you compose the presentation.   

! Grouping images into queues enables you to create a queue for 
each presentation.  That makes it easier to reproduce the 
complete presentation at a later date. 

! Since enhancement settings are maintained with the queue, 
you don’t need to readjust settings each time you output an 
image.  

! Processing high-resolution images takes most of the power 
your Macintosh can muster.  You can process image queues at 
a convenient time, such as over lunch, when you don’t need to 
use your Macintosh for anything else. 
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MacRascol on a Network 
 

With MacRascol Server, it is possible to run the MacRascol 
software over an AppleTalk network in order to share your 
Lasergraphics Film Recorder between many Macintosh users. 
 

MacRascol 
Server

LFR

SCSI

MacRascolRIP MacRascolRIP MacRascolRIP

AppleTalk Network

Client Client Client

 
 

The MacRascol Server application runs on the Macintosh 
connected to the film recorder via the SCSI bus. The MacRascol 
software installed on other Macintosh computers communicate with 
the MacRascol Server using AppleTalk network services. Typically 
Macintoshes communicate with AppleTalk using Ethernet wiring, 
but other types of local area network cabling may be used. 
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What You Need 
 

You need the following hardware and software to run MacRascol.   
 
 

Required Hardware ! Any SCSI capable or AppleTalk capable Macintosh with at least 
a 68020 processor or a PowerPC processor.  (MacRascol 5.1 is 
the last release that supports the 68000 processor.) 

! A Lasergraphics film recorder (LFR) with a SCSI or AppleTalk 
interface option. 

 
 

Required Software ! SCSI LFR Chooser driver (included) for a SCSI-connected LFR, 
or 

 AppleTalk LFR Chooser driver (included) for an AppleTalk-
connected LFR, or 

 LFR Server Chooser driver (included) for an LFR using the 
MacRascol Server application (included), or 

 BLL File Chooser driver (included) for making BLL files. 

! MacRascol Quick Print application (included). 

! MacRascol Queue Builder application (included). 

! MacRascol Print Monitor application (included). 

! MacRascol Server application (included). 

! Macintosh System version 7.0 or later, up to Mac OS 9. 
Mac OS X is not supported (we do not expect MacRascol to 
work under Classic). 

! SimpleText (a simple viewer included with the Mac OS). 

! An application that creates PICT, raster images, Hewlett-
Packard Graphics Language (HPGL), or Lasergraphics 
Language (LL) images or any application able to print using the 
standard Macintosh mechanisms.  Applications that export 
images must be able to save files in PICT, Targa, TIFF, 
Photoshop, or Dicomed Tile format, copy graphics onto the 
Clipboard, drag images to create a clipping, or to create a 
Scrapbook of images. 
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Installation 
 

This chapter describes how to install the MacRascol software. 
 
The first section, “Install Your Film Recorder,” outlines LFR 
installation procedures. 
 
“Install the MacRascol Software” describes installation procedures 
for the MacRascol software. 
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Install Your Film Recorder 
 

MacRascol is compatible with several output devices.  The following 
section provides an overview of a typical LFR installation.  See your 
specific device’s user guide for a complete description of installation 
procedures. 
 

 

An Overview of LFR 
Installation 

 
 

L A S E R G R A P H I C S

 

1. Place the LFR on a smooth, flat surface in a well-ventilated area. 
Make sure the LFR is not in contact with a wall, or any object that 
might propagate vibrations to the LFR. 

 Keep the LFR away from electrical devices and magnets such as 
computer monitors, power supplies, motors, and telephones. 

 

2. If the LFR has an AppleTalk connector, connect it to the network. 

 The LFR uses the standard Macintosh LocalTalk mini-DIN 
connector. Check with your network administrator for the interface 
cabling needed for your office. 

 
3. If the LFR has a SCSI connector, check its SCSI ID number. 

 The LFR is preset to SCSI ID number 4.  The DIP switch on the 
rear panel of the LFR sets the SCSI ID number.  A SCSI utility 
such as the Apple System Profiler can be used to determine if port 
4, the factory set default, is available. If port 4 is not available, 
change the SCSI ID on the LFR to an available port number. 

 
4. Connect the LFR to your Macintosh or another SCSI device. 

 Turn off the Macintosh and all SCSI devices before making the 
connection. 

 
5. Make sure that the SCSI chain is properly terminated.   

 The terminator should be on the last physical device in the 
chain. The LFR is not internally terminated. 

 
6. If your LFR has a removable camera back, remove the dust cover 

from the LFR, remove the lens cover from the camera, mount the 
camera back, lock it in place, and plug in the camera cable. 

 
7. Connect the power cord and turn on the LFR. 

 
8. Load the camera with film. 

 ! NOTE:  The LFR won’t expose any images until it warms up.  
You can send images any time after starting the LFR.  They will 
wait and be exposed when the LFR is ready.  
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Install the MacRascol Software 
 

To install the MacRascol software, you will need the MacRascol CD-
ROM.   
 
 
 ! NOTE:  If your Macintosh has no CD-ROM drive, remember 

that you can always install from a folder over a network or from a 
removable disk. You can install the MacRascol software right out 
of the folder. 

 

1. Disable any virus protection software that might interfere with 
the software installation. 

2. Go to the Finder and insert the MacRascol CD-ROM. 

 

3. Open (or double-click) the Installer icon. At the installer 
message, click on the Continue… button. 

 

4. Set up the configuration options. 

 

 
 

 

 Type in the serial number. The serial number can be found on 
the rear of the film recorder. If there is a dash (-) in the number, 
enter it too. The film recorder pop-up menu should 
automatically change to match the model of film recorder you 
have. 

  

 If the SCSI interface is used to connect to your Macintosh, check 
the first button. If the AppleTalk interface is used, check the 
second button. To connect with the MacRascol Server software 
on another Macintosh, check the third button. 

 Click on the Install button. If the Install button is not enabled, go 
back and check the serial number entry again. 
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5. Check the Destination folder. 

 The software will install into the MacRascol folder and the 
system folder of your startup disk. To choose a different system 
disk, hold down the option key and click on the System Disk 
button. To choose a different MacRascol folder, click on the 
Select Folder button. 

6. Click Install for the Easy Install process. 

 

7. Enter the serial keys as directed. 

 

 
 

 The serial key for MacRascol is shipped with the MacRascol 
software. The serial key for WinRascol is shipped with the 
WinRascol software. You need to enter the WinRascol serial 
key only if you want to use MacRascol to image BLL files 
produced by WinRascol under Windows. 

8. Quit the Installer when done. 

9. Re-enable your virus protection software. 

10. If the MacRascol folder contains a ReadMe file, use SimpleText 
to open the file and read it. 
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These items will be installed on your hard disk in the MacRascol 
folder: 
 

 
The MacRascol folder may contain some SimpleText documents. 

These text documents describe late-breaking information that is 
not included in this guide.   

 

 
The MacRascol Quick Print application can print many kinds of 

graphics documents directly to the film recorder. You can keep 
an alias of this item on the desktop to take advantage of one-
step printing from the Finder. 

 

 

The MacRascol Queue Builder application can group images into 
a queue and enhance the images for high-resolution color 
output. You can keep an alias of this item in the Apple Menu 
Items Folder in the System Folder for more convenient access. 

 

 

PrintMe is a document that you can use if you follow the tutorial in 
the Learning MacRascol chapter. 

 

 

SamplePICT contains a PICT image that you can use if you follow 
the tutorial in the Learning MacRascol chapter. 

 

 

The MacRascol Server application is installed with a SCSI-
connected film recorder. MacRascol Server allows other 
Macintosh computers on your local network to print to the film 
recorder connected to your computer.  

 

These items will be installed on your hard disk in the System folder: 
 

 

SCSI LFR is the Chooser driver that you use with a SCSI-
connected film recorder. Chooser drivers are selected in the 
Chooser desk accessory and used by your application when 
you use the Print command. 

 

 

AppleTalk LFR is the Chooser driver that you use with an 
AppleTalk-connected film recorder. 

 

 

LFR Server is the Chooser driver that you use with the MacRascol 
Server software to print to a film recorder connected to another 
Macintosh. 

 

 

BLL File is the Chooser driver that you use to create BLL files for 
imaging at a later time or at another station. 

 

 

The MacRascolQ Data folder contains supporting data files that 
are used by the MacRascol software. 
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The LFR Mac/PC Harmony is installed with a SCSI-connected film 
recorder. It is useful when a PC is also connected to another 
port of the film recorder; otherwise you can safely move it to the 
Trash. It runs after Mac OS 8 starts up to make sure that the PC 
film recorder port is enabled. 

 
Now you are ready to begin learning to use MacRascol. 
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Learning 
MacRascol 

 

 
This chapter is a tutorial that shows you how to print images on a film 
recorder and to group images into a queue. 
 
The first section, “Preparing for the Tutorial,” describes what you 
need for the tutorial. 
 
“Configure MacRascol” outlines how to set up for printing using the 
Chooser and a MacRascol Chooser driver. 
 
“Print with MacRascol” outlines how to set output options and to 
print images using your application. 
 
“Quick Print” outlines how to set output options and to print 
graphical image files using the MacRascol Quick Print application. 
 
“One Step Printing” outlines how to print graphical image files from 
the Finder. 
 
“Group Images into a Queue” outlines how to build and process an 
image queue. 
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Preparing for the Tutorial 
 

Before starting the tutorial, make sure you have the following items: 
 
! A sample document 

 When you start producing your own presentations, you’ll begin by 
creating image documents with a graphics application.  A sample 
image document, PrintMe, is installed in the MacRascol folder so 
you don’t have to create an image document for this tutorial. 

 
! A sample PICT format image 

 When you start producing your own presentations, you’ll begin by 
creating images with a graphics application.  A sample image, 
SamplePict, is installed in the MacRascol folder so you don’t 
have to create an image for this tutorial. 

 
! Supplies for your output device 

 Your film recorder should have enough film to produce at least 
four images. 
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Configure MacRascol 
 

 The MacRascol Chooser drivers work as your printer driver.  

 

1. Select Chooser from the Apple menu. 

 The Chooser window appears. 

2. Click a MacRascol driver icon in the driver list on the left side of 
the window. 

 Click on SCSI LFR if your LFR is connected to the SCSI bus. 
Click AppleTalk LFR if your LFR is connected to the network. 
Click LFR Server if you are using the MacRascol Server 
software on another Macintosh. 

 

 
 

 The model name and either the SCSI address, AppleTalk 
name, or server name of your film recorder should appear in the 
list on the right side of the window. If it says “Busy FR” you 
should close the Chooser, wait for the film recorder to 
warm up, and try again: the model name cannot be determined 
while warming up. 



24           Learning MacRascol 

 

3. Click the LFR in the list on the right to select it. 

 

 
 

4. Close the Chooser window to complete the selection. 
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Print With MacRascol 
 

 

1. Locate the PrintMe document in the MacRascol folder, and 
double click the file. 

 The SimpleText application will launch and it will open the 
PrintMe document.  You will see a portion of the PrintMe 
image in the window. 

 

2. Choose Page Setup… from the File menu. 

 The Page Setup window appears. Click on the Orientation icon 
on the right with the landscape picture. 

 

 
 

 

3. Change the Background Color to White. 

 Click on the Background Color pop-up menu and select White. 
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4. Click on the Camera Options. 

 The Camera Options window appears. 

 

 
 

5. Set the Film Type and Resolution. 

 To select the film you have loaded into the camera, click on the 
Film Type pop-up menu. To select the resolution you want to use, 
click on the Resolution pop-up menu. 

 

 6. Click OK for Camera Options and OK for Page Setup. 

 

7. Choose Print… from the File menu. 

 The Print window will appear. 

 

 
 

8. Click OK. 

 This will save to disk the PrintMe image in full color. The 
MacRascol Print Monitor will run in the background to process it 
and send it to the LFR. 

 
9. Quit the SimpleText application. 
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Quick Print 
 

MacRascol Quick Print is an application that enables you to print 
many kinds of graphical file formats on the film recorder. 
 

 
1. Locate the MacRascol Quick Print application in the MacRascol 

folder, and double click the icon. 

 

 

2. Choose Page Setup… from the File menu. 

 The Page Setup window appears. Click on the Orientation icon 
on the right with the rotating picture to choose automatic 
orientation. 
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3. Click on the Camera Options Button. 

 The Camera Options window appears. 

 

 
 

 4. Set the Film Type and Resolution. 

 To select the film you have loaded into the camera, click on the 
Film Type pop-up menu. To select the resolution you want to 
use, click on the Resolution pop-up menu. 

 

5. Click OK for Camera Options and OK for Page Setup. 

 

 

6. Choose Print Files… from the File menu. 

 The Print Files window will appear. 
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7. Print the SamplePict document. 

 Find SamplePict in the upper list and click on it. Click the Add 
button and SamplePict will be added to the lower list. 

 

 
 

 Click on the Print button to start printing. The MacRascol Print 
Monitor will run in the background to process and send the 
image to the LFR. 

 

8. Quit the MacRascol Quick Print application. 
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One-step Printing 
 

One-step printing prints graphical files on the film recorder while in 
the Finder. 
 
1. In the Finder, drag the SamplePict file over to the MacRascol 

Quick Print icon so that the icon highlights. Release the mouse 
button. 

 These items were installed in the MacRascol folder. 

 

 
 

 If the MacRascol Quick Print icon does not highlight when you 
drag the file over it, you need to rebuild the desktop. Refer to 
your computer’s documentation or the Macintosh Guide in the 
Finder. 

 The image will be printed using the options most recently set in 
MacRascol Quick Print’s Page Setup window. The MacRascol 
Print Monitor will run in the background to process and send the 
image to the LFR. 
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Group Images into a Queue 
 

 An image queue is a list of images that you want to output.  You 
can create a separate queue for every presentation, or use the 
same queue over and over again. 

 

 

1. Locate the MacRascol Queue Builder application in the 
MacRascol folder, and double click the icon. 

 

 2. Choose Open Preferences from the File menu. 

 The Preferences window appears. This is a table of attributes 
used by the MacRascol Print Monitor to process and print 
images on the film recorder. The Default preference is the 
group of attributes put here during the MacRascol software 
installation process, or when you select a different film recorder 
in the Chooser. 

 

 

  
 

 Note: This picture illustrates a typical use of the Preferences. After 
a fresh install there will be only one entry, matching your film 
recorder model, and the Film Type column will be blank. 

 3. Verify that your film recorder model is correct. 

 If you have only one film recorder attached, the Film Recorder 
column will show its model name. If you believe this is incorrect, 
open the Chooser from the Apple Menu and reselect the film 
recorder as described at the beginning of this tutorial. When you 
close the Chooser and switch back to Queue Builder, the 
Preferences window will be updated to match your film recorder 
model. 

 4. Set the film type of the film you have loaded. 

 Point to the film listed in the Film Type column and pop up a 
menu of film types. Select the type of film that you have loaded. 
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 5. Set the desired resolution. 

 Use the scroll bar at the bottom of the window to find the 
Resolution attribute. Point to the resolution selection and pop up 
a menu of resolution values. Select the resolution desired. 

 

 6. Choose New Image Queue… from the File menu. 

 The directory dialog box appears. 

 

7. Type a name for an image queue (e.g., Tutorial) and click Save. 

 The image queue document named Tutorial appears. An image 
queue window enables you to group images into a queue and 
select images for enhancement.  The window title is the name 
of the queue. 

 

 
 

 
 
 
 



 Group Images into a Queue                33 

  
 

8. Click the Add Many… button (or select Add Many… from the 
Images menu on the menu bar). 

 The Add Many window appears. It is similar to the Print Files 
window encountered in MacRascol Quick Print. 

 

 
 

9. Add the SamplePict document. 

 Click on SamplePict in the upper list. Click the Add button and 
SamplePict will be added to the lower list. Click on the Done 
button to go back to the Tutorial image queue window. 

 

 
 
 

 SamplePict is now the first image in the queue. Its image type is 
PICT and it is waiting to be processed. It has acquired the 
Default preferences that were set up in the Preferences window. 

 

10. Click the Process button (or select Start Processing from the 
File menu on the menu bar). 

 The Tutorial image queue will start printing. The MacRascol 
Print Monitor will run in the background to process and send the 
image to the LFR. 
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 While the image is being processed and printed, its status in the 
image queue window will change to Printing. 

 

 After MacRascol Print Monitor has finished the image, its status 
will change to Done or Error. With the former, the time 
(minutes:seconds) elapsed processing and printing the image is 
displayed. 

 
 

 With the latter, a numeric error code is displayed. 

 
 

 Point to the error code and push the mouse button to pop up 
the menu of status settings. Selecting Error will show a window 
identifying the error. 

 
 Click OK to continue. 

 
11. Choose Quit from the File menu. 
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Using MacRascol 
 

 
This chapter describes specific tasks that you can perform with 
MacRascol and provides guidelines on how to treat specific types of 
images. 
 
The first section, “All About Configuration Options,” further explains 
the details of configuring the software to your film recorder. 
 
“Printing Images” explains how to print images from an application 
program. 
 
“Grouping Images into a Queue” outlines how to select a queue, 
add images, print images into a queue, select, delete, or preview an 
image, and set the image status. 
 
“Working with Preferences” outlines how to create a preference, 
set a default preference, change the preference of one or more 
images, and delete a preference. 
 
“Setting Image Quality” outlines image quality options and outlines 
how to set image quality for specific images. 
 
“Cropping and Sizing Images” outlines how to adjust image size, 
shape, and scale. 
 
“Working with Specific Images” contains suggestions for producing 
images from pictures with fonts, bitmaps, or objects and from BLL 
files. 
 
“Moving and Copying Queues” explains how to move or copy a 
Queue and its image files from one location to another. 
 
“Processing Queues for Output” explains how to start MacRascol 
Print Monitor, open different queues, set film recorder options, and 
begin processing. 
 
“Dropbox Operation” explains how to set up and run a MacRascol 
Quick Print dropbox for automatic printing of image files. 
 
“Server Operation” explains how to set up and run MacRascol 
Server to communicate over the local network. 
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All About Configuration Options 
 

Configuration is telling the MacRascol software how to communicate 
with your film recorder. 
 
Configuring MacRascol includes choosing the communications or the 
BLL File driver and setting the film recorder attributes. These steps 
are explained in the following three sections. 
 

 

Choosing the 
Communications 

1. Select the MacRascol Chooser driver for the communications 
method you want. 

Select the Chooser from the Apple menu. The Chooser window 
appears. Click the driver you want in the driver list on the left side of 
the window. 

 
 The SCSI LFR driver uses the SCSI bus to locate the film 

recorder. Select this one if the film recorder hardware is directly 
connected to your Macintosh with SCSI cables. 

 The AppleTalk LFR driver uses the network to locate the film 
recorder. Select this one if the film recorder hardware is directly 
connected to your network. 

 The LFR Server driver also uses the network to locate the film 
recorder. Select this one if the film recorder hardware is directly 
connected to another Macintosh on your network with SCSI 
cables. The other “server” Macintosh must be running the 
MacRascol Server application. Any Macintosh on the network 
can communicate with this application and it will relay the 
information to the film recorder. 

 The BLL File driver converts images into BLL graphics files. 
Select this one if you need to save images for output on the film 
recorder later, or are using the “drop box” network printing 
feature of MacRascol or WinRascol. See the following section 
to choose the BLL File driver. 
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2. Click the LFR in the list on the right to select it. 

When you selected the driver icon from the left, the driver starts 
searching for all the Lasergraphics film recorders that it can find. If a 
film recorder is found with the same SCSI address or server name 
that it was the last time the driver was selected, it will be highlighted 
without clicking. 

 
Make sure that the LFR you want is highlighted in the list on the 
right. This causes the software to ask for the rest of the 
configuration information from the film recorder hardware itself. 

 
3. Optional: Click on the Get Info button to see the capabilities of 

the LFR hardware. 

 
4. Optional: Click on the Manual Setup… button to set or check 

the configuration. 

The film recorder you want will not be listed on the right if it is 
turned off or not available on the network. You must then manually 
configure it. 

 
 From the Manual Setup window you can change the SCSI Bus 

and ID or Server Name. If this is not correct, the Print Monitor 
will be unable to send the image to the film recorder. 

 Check if the Film Recorder model is correct. If this is not 
correct, the MacRascol software may process the image 
incorrectly. It may try to use the wrong resolution or film 
calibration. 

 You can check the Use RISC Rascol or Internal Rascol box if 
your configuration includes Rascol hardware and you would like 
to use it for rasterization. These days Macintosh CPUs are so 
fast that these hardware options are effectively obsolete. In 
general, you should leave this box unchecked. 

 If you check Reserve server between images, then you will 
prevent other Macintosh users from using the film recorder 
while you are sending a group of images. 

5. Close the Chooser window. 
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Choosing the BLL File 
Driver 

1. Select the BLL File Chooser driver. 

Select the Chooser desk accessory from the Apple menu. The 
Chooser window appears. Click BLL File in the driver list on the left 
side of the window. 

 
 The BLL File driver converts images into BLL graphics files. 

Select this one if the film recorder hardware is not available to 
your Macintosh. 

 BLL files capture the configuration of your Macintosh (such as 
what fonts you have), and can be imaged accurately on a film 
recorder connected to another Mac or PC. The Mac or PC with 
the LFR attached does not need your fonts or clip art loaded to 
image your BLL file. All such attributes are embedded in the 
BLL file. 

2. Click on the Setup… button to set or check the configuration. 

 From the Setup window you Select a Folder for the MacRascol 
Print Monitor to place the BLL files as they are generated. You 
may select a removable disk if you are sending the files to a 
service bureau. 

 You may select a special folder on your network designated as 
a drop box for the MacRascol or WinRascol software. 
WinRascol software runs under Windows and can image BLL 
files to a film recorder attached to a PC. WinRascol is available 
from Lasergraphics or your dealer. 

 Check Use DOS compatible filenames to minimize compatibility 
problems if the files may be moved to a non-Macintosh disk or a 
WinRascol drop box. 

 Be sure and set the correct Film Recorder type. If this is not 
correct, the BLL file may not be able to be processed. It may 
have the wrong resolution or film calibration. 

3. Click the Choose “folder name” button to complete the 
configuration. 

 The button will show the name of the folder selected. 

4. Close the Chooser window. 
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Set the Film Recorder 
Attribute 

If the Film Recorder setting is not correct, the MacRascol software 
may process the image incorrectly. It may try to use the wrong 
resolution or film calibration. 

 
When you use a MacRascol Chooser driver to print images 
directly from your application, then the set up of film recorder 
type is already done. You can skip this section. 

 
MacRascol Quick Print also uses the MacRascol Chooser driver to 
print. This section also is not relevant to Quick Print users. 
 
MacRascol Queue Builder provides a more powerful method of 
preparing files to be imaged. It allows the film recorder type to be 
changed and varied so that queues for different film recorders can be 
built. When the queues are being built, the values for Film Recorder 
in the queue should match the type of film recorder intended for 
output. When the queues are output by MacRascol Print Monitor, the 
values must match. Here are three methods to do this: 

 
1. Print images into a queue. 

When the film recorder type is set up correctly in the MacRascol 
Chooser driver, then the type is copied to the Film Recorder 
attribute value in the queue entry. 

 
2. Set up preferences with the correct Film Recorder attribute 

value. 

As you set up preferences in the Preferences window, make sure 
you set the correct Film Recorder value. When you add files to a 
queue, the correct value will be copied to the queue. 

 
If you set up preferences with different Film Recorder values, then be 
sure when you add files that the default preference (the topmost one 
in the Preferences list) has the correct value. 

 
3. Set all images to the correct Film Recorder attribute value. 

Show the Film Recorder attribute in your queue list. Make sure that 
all items in the queue have the correct value. 
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Printing Images 
 

You print images into a queue with a MacRascol Chooser driver. The 
driver substitutes for your printer driver. 
 
Whenever you select Print in your application, MacRascol captures 
the image in a disk file. The file is added to an image queue, and may 
be enhanced and processed with the other MacRascol software. 
Normally, the queue is processed immediately by MacRascol Print 
Monitor and the images are sent to the film recorder. 
 

Printing images into a queue includes these steps: 
 
1. Configure MacRascol in the Chooser. 

Refer to the previous section on configuration options. 
 
2. Select the Page Setup parameters. 

Page Setup parameters are discussed next. 
 
3. Print the images. 

The Print parameters are covered last in this section. 
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Selecting the Page Setup 
Parameters 

 The Page Setup parameters are saved with each document 
you have.  The MacRascol Page Setup window shows the 
saved settings from the active document. 

 

1. Bring your document window to the front. 

 
2. Choose Page Setup from the File menu, or bring up the Page 

Setup window by following the printing instructions given by your 
application. 

 The Page Setup window is displayed. 

 
 
3. Click one of the orientation icons to select either “portrait” or 

“landscape.” 

 This will affect the page area displayed in your document 
window. 

 
4. Type in a percentage in the box to reduce or enlarge the image 

(20% to 500%). 

 A percentage less than 100% will reduce the image on the page 
by making the page area displayed in your document window 
larger. A percentage greater than 100% will enlarge the image on 
the page by making the page area smaller. Adjust the percentage 
to the most appropriate page size for your document. You may 
want to experiment with different values. 

 
5. Check Native Resolution only if your output is low quality or the 

wrong size. 

 For some older applications, changing the Native Resolution flag 
may affect the page area displayed in your document window. 

 
6. Check Blend Patterns to blend the colors of object patterns in 

your document. 

 If your document uses patterns to simulate more colors on the 
screen, then this option will blend the pixels of the pattern and 
paint the film with a solid color. If your document uses patterns to 
simulate textures, do not check this option. 

 
7. Check Invert Black and White if you need to change the colors 

in your slide. 

 If your document uses black lines on a white background, then 
you may want to check this box when making slides. 
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8. Click the Camera Options or Color Balance buttons to set 
image quality options. 

 You need to set the film type and other image quality options. 
The settings for these options are discussed in the “Setting Image 
Quality” section later in this chapter. 

 
9. Click the Save as Default button to remember these Page Setup 

settings for new documents. 

 The application normally saves the settings you have made in the 
Page Setup window with this document. Clicking the Save as 
Default button also saves this set of settings for new documents 
that you create in this and other applications. 

 
10. Click OK. 

 The application will change the page area of your document 
based on the settings you have made in the Page Setup window. 
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MacRascol Quick Print 
Page Setup Parameters 

 The Page Setup parameters of MacRascol Quick Print are 
saved for all files subsequently printed with MacRascol Quick 
Print. 

 1. Start MacRascol Quick Print and choose Page Setup from the 
File menu. 

 You can also get the Page Setup window by holding down the 
control key while dragging a file to the MacRascol Quick Print 
Icon. A modified Page Setup window is displayed. 

 

 
 
 

 2. Type in the number of copies to make of each image. 

 
 

3. Click one of the orientation icons to select either “portrait,” 
“landscape,” or “automatic.”  

 This option only affects PICT and Print image files. If automatic 
is selected, the orientation that best matches the shape of the 
image will be chosen. 

4. Check Fine Character Spacing if the files require it. 

 This option only affects PICT image files. Usually this box should 
be checked. 

5. Check Blend Patterns to blend the colors of object patterns in 
your document. 

 This option only affects PICT and Print image files. If your image 
files use patterns to simulate more colors on the screen, then 
this option will blend the pixels of the pattern and paint the film 
with a solid color. If your files use patterns to simulate textures, 
do not check this option. 

6. Check Invert Black and White if you need to change the colors in 
your slide. 

 This option only affects PICT and Print image files. If your files 
use dark lines on a white background, then you may want to 
check this box when making slides. 

7. Click the Camera Options or Color Balance buttons to set image 
quality options. 

 You need to set the film type in the Camera Options window. 
The settings for these options are discussed in the “Setting 
Image Quality” section later in this chapter. 
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8. Click the Raster Scaling button to set raster file options. 

 This option only affects TIFF, Targa, Photoshop, and Dicomed 
Tile image files. The settings for these options are discussed in 
the “Cropping and Scaling” section later in this chapter. 

 

9. Click the Pen Colors button to set HPGL file options. 

 This option only affects HPGL image files. 

 

10. Click OK. 

 The options will be saved for the next time you print with 
MacRascol Quick Print. 
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Printing to the LFR  Designate an image queue and preferences in the Print 
window. The images are captured from the application each 
time Print is performed. 

1. Bring your document window to the front. 

2. Choose Print from the file menu. 

 The Print window will be displayed.  Yours may vary slightly. 

 

 
 
 
3. Type in the number of copies to make of each image. 

4. Select a page range if desired. 

5. Select printing mode. 

 Color/Grayscale is the normal mode. 

6. Select Direct to LFR as the Destination. 

7. Click OK. 

 The designated pages will be added to the Print Queue. The 
MacRascol Print Monitor will start to send the image(s) to the 
LFR. 
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Printing Images into a 
Queue 

 You can designate an image queue in the Print window. The 
images are captured from the application each time Print is 
performed. Then they can be manipulated with the MacRascol 
Queue Builder. 

1. Bring your document window to the front. 

 
2. Choose Print from the file menu. 

 
3. Push on the Destination menu to select the image queue. 

 
 
 Select New Image Queue… to create a new queue or Other 

Image Queue… to open an existing queue. The most recently 
used queue may also be selected from the bottom of the list. 

 The Print Queue (located in the MacRascolQ Data folder inside 
your System folder) is the one used to print immediately. Usually 
you will designate a different queue. 

 
4. Click OK. 

 The designated pages will be added to the image queue. The 
image queue you choose will be remembered for the next time 
you print. 
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Grouping Images into a Queue 
 

You can print images to a queue (as described in the last section) 
or use the MacRascol Queue Builder application to add images to a 
queue. You can work with just one image queue by adding and 
deleting images as required, or you can create and use multiple 
queues. 
 
Multiple queues enable you to work with one queue in MacRascol 
Queue Builder while MacRascol Print Monitor processes another 
queue. You can also organize presentations into individual queues. 
 
Grouping images into a queue includes these steps: 
 
1. Selecting a queue 

2. Adding images to the queue 

3. Selecting an image 

4. Deleting an image (if necessary) 

5. Setting image status 

 
These steps are explained in the following five sections.  Not all steps 
are required for adding an image, but each step is a basic queue 
operation.  
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Selecting a Queue  
MacRascol Queue Builder automatically opens the last queues 
used. 

 
! NOTE:  To use MacRascol Queue Builder to monitor processing, 
you must open the queue being processed. 
 
 
To Create a New Queue 

1. Open MacRascol Queue Builder. Choose New Image Queue 
from the File menu. 

 A dialog box appears. 

 
2. Open the folder in which you want to save the queue. 

 
3. Type a name for the queue (for example, First Queue). 

 
4. Click Save. 

 An empty queue is created. 
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To Open an Existing Queue 

You may want to open an existing queue to make changes or to 
continue working. 
 
1. Open MacRascol Queue Builder. Choose Open Image Queue 

from the File menu. 

 A dialog box lists folders and queues in the current directory. 

  
 

2. Select the queue you want to open. 

 You may need to change directories in order to find the desired 
queue. 

 
3. Click Open. 

 The contents of the queue are displayed in an image queue 
window. 
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To Open the Print Queue 

 You may want to open the Print Queue to make changes or to 
continue working.  The Print Queue can be manipulated like other 
queues, but entries will be deleted from the Print Queue as soon as 
MacRascol Print Monitor is done with them.  See the subsection “To 
Begin Processing the Print Queue” in the section “Processing 
Queues for Output” for a further description of Print Queue 
operation. 
 
 Open MacRascol Queue Builder. Choose Open Print Queue 

from the File menu. 

 MacRascol Queue Builder opens and displays the contents of 
the Print Queue. 
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Adding Images   
You can add graphic images to a queue from a file and PICT 
images from the Clipboard, a drag, a Scrapbook, or a Clipping.  You 
can also add images to the queue by using a MacRascol Chooser 
driver from any application through the Print… command.  (Refer to 
previous section titled “Printing Images into a Queue.”) 
 
 
This table lists the file formats currently supported by MacRascol: 
 

File Format Mac File Type  File Name Suffix 
PICT PICT   
Scrapbook ZSYS or scbk  .PSD or .TIL or .TILE 
MacRascol Print SFcd   
Binary Lasergraphics Language (BLL)   .BLL 
Lasergraphics Language (LL) TEXT   
Hewlett Packard Graphics Language (HPGL) TEXT   
Tagged Image File Format (TIFF) TIFF or .TIF  .TIFF 
Targa TPIC or .TGA 
Adobe Photoshop 2.0 8BIM   
Adobe Photoshop 2.5 8BPS or .PSD 
Dicomed Tile File   .TIL  .TILE 

 
When you add an image through MacRascol Queue Builder, the 
image is not actually stored in the queue.  Instead, an alias to the 
image file is created and stored inside the queue.  When you add 
images files from a floppy disk or from a remote file server to your 
queue, you will not be able to use these files when the floppy disk is 
not inserted or the remote file server is not mounted.  In this case you 
may wish to copy the image files to your hard drive first before you 
add them to your queue.  Instead of copying these files yourself, you 
can use the Add the copy of this file feature to have MacRascol 
Queue Builder make the copy for you. The copy is placed in a folder 
within the same folder as the queue.  The folder is named 
queuename-Images, where queuename is the name of the queue.   
 
Images on the Clipboard, in a drag, or in a Scrapbook or Clipping 
document don’t exist as permanent files. A file is automatically 
created for each image added from these sources. These files are 
stored in the queuename-Images folder. 
 
If you are preparing images for a film recorder, you can add more 
images than there is film in the camera.  If the camera runs out of film 
while processing a queue, the film recorder will stop and let you 
change the film. 
 
The user is responsible for setting the correct image shape for the 
files added to a queue. The image’s shape is set within the 
application that produced the image. Unusual shapes can cause 
undesired effects. For example, a file set up with a standard 8.5˝ x 
11˝ page size will image on a 35mm slide with left and right margins. 
The size to fill the 35mm film format is any with a height that is 2/3 of 
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the width. This is sometimes stated as a 2:3 aspect ratio. Other film 
sizes have other aspect ratios. 
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To Add an Image From a File 

 
You can add images from graphics files. 
 
1. Activate an image queue window. 

 
2. Click Add Image. 

 A dialog box lists the type of files selected by the File Type 
menu as well as folders in the current directory. 

 

  
 
3. Select the file type (or All) you want to add to the queue. 

 
4. Select the file you want to add to the queue. 

 
5. If you want a copy of the file to be added instead of the original, 

click on the Add the copy of this file checkbox. 

 The file will be copied into the queuename-Images folder and 
added to the queue.  This feature is useful if you wish to make 
your queue and its associated files easily portable.  See the 
section “Moving and Copying Queues” later in this chapter. 

 
6. Click Add. 

 The file is added to the end of the image queue.   

 

 

To Add Many Images From Files 

You can add images from many graphics files at once. 
 
1. Activate an image queue window. 
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2. Click Add Many. 

 A dialog box lists the type of files selected by the File Type 
menu as well as folders in the current directory. 

  
3. Select the file type you want to add to the queue. 

 
4. Select each file you want and then click Add, or double click on 

each one.  Click Add all to add all files in the current directory. 

 The files are added to the end of the Files to open list. 

 
5. Remove files from the Files to open list (if necessary) by 

selecting them and clicking Remove. 

 

6. If you want copies of the files to be added instead of the originals, 
click Add the copies of these files. 

 The files will be copied into the queuename-Images folder and 
added to the queue. This feature is useful if you wish to make 
your queue and its associated files easily portable.  See the 
section “Moving and Copying Queues” later in this chapter. 

 
7. Click Done. 

 The files in the Files to open list are added to the queue. 

 

To Drag Image Files From the Finder 

You can also add images from graphics files with the Finder. 
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1. Arrange the windows so that you can see the image files in the 
Finder and also see an image queue window. 

2. Select one or more image files. 

3. Drag the icons, positioning them over the image queue window, 
and drop them in. 

 As the cursor moves over the image queue window, that window 
should show a highlight color around the edges. 

 

 

To Add an Image From the Clipboard 

 
When you add an image from the Clipboard, a folder is created in the 
same folder as the queue and an image file is stored in it. The file is 
named Clipboard number, where number is a sequential number 
beginning with 1. 
 
1. Copy a PICT image onto the Clipboard. 

 Generally, any image you copy to the clipboard becomes a PICT 
image.  Some applications (e.g., Adobe Illustrator) require special 
commands to copy a PICT representation of an image to the 
Clipboard. 

 
2. Activate an image queue window. 

 
3. Click Paste. 

 A PICT file is created in the queuename-Images folder. The 
image is added to the end of the image queue.   

 
 NOTE:  Some presentation applications do not copy the slide 

background to the clipboard. Only the text and graphic objects 
appear in the slide output. Check in the cropping window to see if 
you are getting what you expect. See Cropping and Sizing 
Images section later in this chapter. 

 

 

To Drag an Image From an Application 

 
When you add an image from a drag, a folder is created in the same 
folder as the queue and an image file is stored in it. The file is named 
Clipping number, where number is a sequential number beginning 
with 1. 
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1. Activate an application window with an image in it. Arrange the 
windows so that you can also see an image queue window. 

2. Select all or a portion of an image in an application window. 

3. Drag the image out of the application window, position it over 
the image queue window, and drop it in. 

 As the cursor moves over the image queue window, that window 
should show a highlight color around the edges. 

 
 NOTE:  Some applications will not drag images at all. Some 

others will only drag images within their own windows but not to a 
window of another application. 

 NOTE:  Some presentation applications do not drag the slide 
background or template. Only the text and graphic objects of the 
slide can be dragged. Check in the cropping window to see if you 
are getting what you expect. See Cropping and Sizing Images 
section later in this chapter. 

 

 

To Add Images From a Scrapbook 

 
The standard Scrapbook desk accessory stores images in a file 
named Scrapbook file inside the System folder.  However, some 
applications can create multiple Scrapbooks with different names and 
store them anywhere on a disk.  MacRascol Queue Builder can open 
any of these Scrapbooks. 
 
When you add images from a Scrapbook, only PICT images are 
added to the queue.  Other types of data in the Scrapbook are 
skipped. 
 
1. Activate an image queue window. 

 
2. Click Add one. 

 
3. Select Scrapbook in the File Type menu. 

 A dialog box displays a list of folders and Scrapbooks in the 
current volume or folder. The option Add the copies of these 
files is always on for Scrapbook files. 

 
4. Select the Scrapbook file you want to add. 

 
5. Click Add. 

 All PICT images in the Scrapbook are added to the end of the 
image queue.   
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Selecting an Image You select an image in a MacRascol Queue Builder image queue 
window by clicking its name.  The selected image is highlighted. 
 

 
 
 

 

Selecting Multiple Images You may select a group of images to delete, reorder, or assign a 
preference, background, or status. 
 
1. Activate an image queue window. 

 
2. To select more than one image, hold the command key down 

while clicking individual images. To select a contiguous range, 
hold the shift key down while clicking. 

 These images will be highlighted to indicate they are selected. 

3. If you have selected one or more images by mistake, you may 
deselect them by holding the command key down and clicking 
them. 

 
 
 
4. You may perform any of the operations on the selected images 

that you would on a single image.  (See specific operation 
instructions for details).  
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To Reorder Images You may reorder the images in the queue any time after you have 
added them.  Note that the order of images in the queue is the order 
MacRascol Print Monitor will print them. 
 
1. Activate an image queue window and select the image or images 

to move. 

 
2. Click and hold on any of the selected images, and drag them to a 

new location. 

 When moving the images, a small triangular indicator appears on 
the left side of the images.  It will move with the pointer to indicate 
where the images will be inserted. 

 
 
 The selected images will be moved together to where the 

indicator is pointing; they will remain selected. 
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Deleting Images 1. Activate an image queue window and select the image or 
images to be deleted. 

 
2. Click Delete Image. 

 The selected image or images are deleted from the queue. 

 
The image file itself is left untouched except if a copy of the image 
had previously been placed in the queuename-Images folder.  In that 
case, that copy is deleted.  Such copies are made when: 
 
! You select Add the copy of this file. 

! You paste from the clipboard. 

! You drag an image from an application. 

! You add a scrapbook. 

! You add a PICT clipping. 

! You use a MacRascol Chooser driver to add images. 

 
If the image was added by placing the image file in a MacRascol 
Quick Print dropbox, then the file was moved to the Printing-Images 
folder inside of the dropbox. When these images are deleted from the 
Print Queue, then the files are deleted also. 
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Setting Image Status Image status defines what happens when MacRascol Print Monitor 
processes the queue. The following table describes the status 
settings. 
 

Status Description 

Waiting 
Indicates the image is to be produced on an output 
device. 

Hold 
Causes the image to be skipped during 
processing. 

Done 
Causes the image to be skipped during 
processing. 

 
Both Hold and Done cause an image to be skipped.  Which one you 
use depends on why you want to skip a specific image. 
 
Use Hold when you don’t want to process an image immediately, but 
you may want to at a later date.  Use Done to skip an image that you 
will not want to process later on.   
 
When MacRascol Print Monitor finishes processing an image (in any 
queue but the Print Queue), it sets that image’s status to Done.  This 
way, you will know at a glance which images you want to process at a 
later date—those marked Hold.  
 
Note that if MacRascol Print Monitor is processing the Print Queue, 
the image will be deleted upon successful completion.  See the 
subsection “To Begin Processing the Print Queue” in the section 
“Processing Queues for Output.” 
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To Change the Status of a Specific Image 

1. Activate an image queue window and select an image. 

 
2. Point to the status column value of the selected image.  Press 

and hold the mouse button. 

 A pop-up menu lists status options.   

 

 
3. Drag through the list to select a new status. 

 
To Change the Status of Multiple Images 

1. Activate an image queue window. 

 
2. Select the images to be changed. 

 
3. Point to the status column of one of the selected images.  Press 

and hold the mouse button. 

 A pop-up menu lists status options.   If all the images you have 
selected have the same status, you will see a check mark next to 
the current status. 

 

 
 If the images you selected have different status settings, then you 

will see an item called No Change. 

 

 
4. Drag through the list to select a new status or select No Change 

to leave the status settings as they are. 
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Working with Preferences 
 

Preferences let you set image quality, cropping, scaling, and other 
options automatically by applying a preference to a single image or 
all images.  Think of preferences as styles in a word processing 
application. 
 
Preferences are helpful if you have a number of images with similar 
patterns, cropping requirements, or options.  You set these items 
for a preference and then apply the preference to all similar images. 
 
There is a special preference, called the Default Preference, that 
can make this process even easier. MacRascol Queue Builder 
automatically assigns the Default Preference to items as they are 
added to a queue.  However, images added by using the Print 
command, which uses a MacRascol Chooser driver, are assigned 
attribute values from the Page Setup and Print windows. 
 
 
If you change any attribute values for the selected image, its 
preference name changes to Custom.  This lets you know that its 
settings differ from those defined for any preference.  The changes 
made apply only to the selected image and have no effect on other 
images that use the preference. 
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To Create a Preference This section describes how to create a preference that automatically 
sets attribute values. 

 
 

 For example, you can create a preference for each type of image 
you create, or for each user or customer, or for each of the film 
types that you use. 
 
 

 1. Open MacRascol Queue Builder. Choose Open Preferences 
from the File menu. 

 2. Select a preference whose settings you want to use as a start. 

 3. Choose Duplicate from the Edit menu. 

 A dialog box appears. 

  
 

4. Type a name for the preference and click Save.   

 You’ve created a preference that has the same settings as the 
original preference. 

 5. Alter the values of the new preference to the settings you 
desire.   

 The new preference can be selected from the Preferences pull-
down menu. 

 
 

 

To Create a Default 
Preference 

Images added to a queue by using MacRascol Queue Builder adopt 
the Default Preference. If you want certain settings initially to be 
the same for all images you add using MacRascol Queue Builder, 
no matter what queue you are working on, create a Default 
Preference. 

 
1. Activate the MacRascol Queue Builder Preferences window and 

select a preference you want to use as the Default Preference. 

 
 
2. Drag the name of the Preference to the top of the list. 

 
 
 The preference on the top of the list becomes the default 

preference for items added to any image queue window. 
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To Change the Preference 
of a Single Image 

You can copy all the settings of a preference to an image. This way, 
you don’t have to reset all the image settings manually. 

 
1. Activate an image queue window in the MacRascol Queue 

Builder and select an image. 

 
2. Find the Preferences attribute column. 

 Make sure that the Preferences entry in the Attributes menu (of 
the menu bar) has a check mark next to it. You may have to scroll 
right or left in the window to find the Preferences column. 

3. Point to the setting in the Preferences column.  Press and hold 
the mouse button. 

 A pop-up menu lists available preferences. 

 
 
4. Drag through the list to select a preference. 

 When you release the mouse button, the image’s preference 
changes to the selected preference.  
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To Change the 
Preferences of Multiple 
Images 

You can copy all the settings of a preference to many images at 
once. This way, you don’t have to reset all the image settings 
manually. 

 
1. Activate an image queue window in the MacRascol Queue 

Builder and select the images. 

2. Point to the Preferences column of one of the selected images. 
Press and hold the mouse button. 

 A pop-up menu lists available preferences.  If all the images you 
have selected have the same preference, you will see a check 
mark next to the current preference.  If the images you selected 
have different preferences, you will see a tick mark next to each 
one, and an additional item called No Change. 

 
 
3. Drag through the list to select a preference or select No Change 

to leave preferences as they are. 
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To Create a Preference 
from an Image Queue Item 

You can copy all of the settings of an image queue item to make a 
preference. This way, you can save the settings and later assign 
them to other items. 

 
1. Activate an image queue window in the MacRascol Queue 

Builder and select an image. 

 
2. Choose Copy from the Edit menu. 

 
3. Activate the Preferences window and choose Paste from the Edit 

menu. 

 A dialog box appears. 

 

 
 
4. Type a name for the preference and click Save.   

 
 You’ve created a preference that has the same settings as the 

image queue item. 
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To Delete a Preference When you delete a preference, images that already use the 
preference will still work fine.  
 
1. Activate the MacRascol Queue Builder Preferences window and 

select the preference you want to delete. 

 
 
2. Choose Clear from the Edit menu. 

 The Preference is deleted. 
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Setting Image Quality 
 

This section describes how to set image quality for specific images.  
To set image quality for an entire queue, see the sections “Setting 
Film Recorder Options” later in this chapter. 
 
 

 

Image Quality Options Image quality options control the resolution and color fidelity of your 
finished images.  When you add an image to a queue, it is preset to 
use the settings specified in the Default Preference. (See the 
previous section.) 
 
Film Type is the most important setting for the image. It specifies the 
carefully controlled amount of light required to get the most out of the 
film. The film type controls are slightly different for each model of film 
recorder Lasergraphics makes, due to differences in optics and 
driving electronics. 
 
Color Balance and Gamma controls are available to modify the film 
type setting. Color Balance controls the amount of light that can be 
applied to any dot in the image. Gamma controls the contrast of the 
image, or the amount of light applied for the middle-value colors of 
the image. 
 
Resolution controls the number of dots in the image. 16K (Ultra 
Fine) generates 16384 by 10922 dots, 8K (Extra Fine) generates 
8192 by 5461 dots, 4K (Fine) generates 4096 by 2731 dots and 2K 
(Fast) generates 2048 by 1365 dots. The actual number of dots 
imaged on the film may be slightly more or less than this, depending 
on its shape. 
 
AntiAliasing adjusts how the image is rasterized. A higher level of 
antialiasing will smooth out jagged edges at the expense of longer 
processing time. 
 
Minimum Exposure Time can help to smooth out lines caused by 
the film recorder stopping and starting. 
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Setting Image Quality from 
an Application or Quick 
Print 

Before printing a document from an application program, or printing 
a file with MacRascol Quick Print, you need to set up the image 
quality options. 
 
Image quality options are normally retained with the document by 
the application program. MacRascol Quick Print, however, keeps 
only one set of image quality settings for all files that it prints. 
 
1a. Activate the document window in the application, or 

1b. Open MacRascol Quick Print. 

 
2. Choose Page Setup… from the File menu. 

 Note that the procedure for bringing up the Page Setup window 
differs for some applications. Verify that the window is titled with the 
name of the driver (e.g., “SCSI LFR Page Setup”). If not, go back to 
the Chooser and select the appropriate MacRascol Chooser driver. 
 

 
 
3. Click on Camera Options. 

 The window with the image quality settings appears. 
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The Camera Options Window 

The Camera Options window lets you view and change the image 
quality settings. 
 

 
 

The Film Recorder setting selects the options available for each 
model and the basic film exposure parameters for the hardware. 
Verify that the correct film recorder is listed at the top of the window. 
If not, go back to the Chooser to set it properly. 
 
The Film Type, Resolution, and AntiAliasing controls are pop-up 
menus. Push on the value to adjust the setting. 
 
The Minimum Exposure Time command allows you to match the 
timing of your film recorder to the MacRascol rasterizer in order to 
eliminate image artifacts that appear when the film recorder is forced 
to wait for data from the rasterizer.  To use this pacing function, you 
set the minimum recording time for the film recorder. 
 
To enable the pacing function, click the button or box next to Minutes, 
and enter the minimum exposure time in minutes and tenths of 
minutes.  To disable the pacing function, click Fastest Possible. 
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The Color Balance Window 

The Color Balance window lets you change the color balance and 
gamma settings. Bring up the Color Balance window by clicking the 
Color Balance button in the Page Setup window, or by clicking the 
Color Balance: Set button in the Camera Options window. 
 

 
 
The Color Balance command lets you change the amount of red, 
green, and blue in the image. You can also affect the overall 
brightness of the image by adjusting the Brightness value. 
 
Adjust the percentages of Red, Green and Blue by dragging the scroll 
bars or by clicking the text boxes below the scroll bars and typing in 
new values. 
 
 Increasing or decreasing the Brightness value changes Red, 

Green, and Blue together.  The overall brightness of the output 
image increases or decreases respectively, but the color balance 
remains unchanged. 

 
Adjust the Gamma value by dragging the scroll bar below the graph 
or by clicking the text box next to the scroll bar and typing a new 
value. 
 
 You may set the value of Gamma in the range of 1/7 to 7 (0.14 to 

7.00).  However, useful values are usually between 0.25 and 
2.00.  By adjusting Gamma you can affect the midtones of the 
image without affecting the highlights. See the section on Color 
Balance in the MacRascol Chooser Driver Reference chapter for 
more details. 
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Setting Image Quality in 
an Image Queue 

MacRascol Queue Builder allows you to view and change the image 
quality settings of many images quickly and easily. 
 
When the image quality in a preference is set properly, you can 
assign the image quality settings to the images in a queue as a 
group (in one step). 
 
When you want to vary the image quality settings from one image to 
the next, then you can view and change them from the image 
queue window. 
 
To Change the Image Quality Settings for a Preference 

1. Open MacRascol Queue Builder. 

 
2. Choose Open Preferences from the File menu. 

 
3. Verify that the image quality attributes are shown in the 

Preferences window. 

 The attributes dealing with image quality are Film Recorder, Film 
Type, Resolution, AntiAliasing, Minimum Exposure Time, and 
Color Balance & Gamma. To view an attribute in the Preferences 
window, make sure that there is a check mark next to the name 
of attribute in the Attributes menu (in the menu bar). 

4. Point to the value to change and push the mouse button. Select 
the new value from the pop-up menu. 

 The Film Recorder setting selects the options available for each 
model and the basic film exposure parameters for the hardware. 
Make sure that the correct film recorder is listed in the Film 
Recorder column. If not, then set it properly now. 

 Select the Film Type, Resolution, and Antialiasing as desired 
from the pop-up menus. 

 The Minimum Exposure Time and the Color Balance & 
Gamma pop-up menus list all the values from the list, and 
Other… to select a new value. See the sections on Minimum 
Exposure Time and Color Balance in the MacRascol Queue 
Builder Reference chapter for more details. 
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To Change the Image Quality Settings for an Individual 
Image 

1. Open MacRascol Queue Builder. 

 
2. Open the image queue you want to modify. Select the window. 

 
3. Verify that the image quality attributes are shown in the window. 

 The attributes dealing with image quality are Film Recorder, Film 
Type, Resolution, AntiAliasing, Minimum Exposure Time, and 
Color Balance & Gamma. To view an attribute in an image queue 
window, bring the window to the front and make sure that there is 
a check mark next to the name of attribute in the Attributes menu 
(in the menu bar). 

4. Select an image or images. Point to the value to change and 
push the mouse button. Select the new value from the pop-up 
menu. 

 The Film Recorder setting selects the options available for each 
model and the basic film exposure parameters for the hardware. 
Make sure that the correct film recorder is listed in the Film 
Recorder column. If not, set it properly now. 

 Select the Film Type, Resolution, and Antialiasing as desired 
from the pop-up menus. 

 The Minimum Exposure Time and the Color Balance & 
Gamma pop-up menus list all the values from the list, and 
Other… to select a new value. See the sections on Minimum 
Exposure Time and Color Balance in the MacRascol Queue 
Builder Reference chapter for more details. 
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Cropping and Sizing Images 
 

MacRascol provides a variety of ways for you to crop and size 
images for high-resolution color output. 
 
You can: 

 
! Set image orientation. 
! Reduce or enlarge the document’s page size.  
! Adjust the document resolution.  
! Match the pixel aspect ratio of an image capture device.  
! Resample the pixels of a raster image. 
! Crop images.  
 

If you wish to apply the same enhancements to multiple images, you 
can group the enhancements together as a new “preference.”  You 
can then enhance future images in the same way by selecting the 
same preference. 

 

To Set Image Orientation MacRascol software lets you orient your image vertically or 
horizontally on the film. The horizontal, or landscape, orientation is 
the natural one to use for slide presentations. The vertical, or 
portrait, orientation is suitable for some types of images, depending 
on the content of the image. 
 
 
To Set the Orientation of a Document 

1. Activate the document window in your application. 

 
2. Choose Page Setup… from the File menu. 

 Note that the procedure for bringing up the Page Setup window 
differs for some applications. Verify that the window is titled with the 
name of the driver (e.g., “SCSI LFR Page Setup”). If not, go back to 
the Chooser and select the appropriate MacRascol Chooser driver. 
 

 
 
3. Set the orientation by clicking on the Portrait or Landscape icon. 

Click OK. 

 In most applications, the boundaries of the page now show to 
the orientation chosen. 
 
 
To Set the Orientation for MacRascol Quick Print 
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1. Open MacRascol Quick Print. 

 
2. Choose Page Setup… from the File menu. 

 

 
 
3. Set the orientation by clicking on the Portrait, Landscape, or 

Automatic icon. Click OK. 

 Files printed with MacRascol Quick Print will be imaged using 
the orientation chosen. If Automatic is chosen, the MacRascol 
software will choose the orientation that best fits the image. Note that 
this option will only affect PICT and MacRascol Print files. 
 
 
To Set the Orientation in MacRascol Queue Builder 

1. Open MacRascol Queue Builder. 

 
2. Choose Open Preferences from the File menu, or open the 

image queue you want to modify. Select the window. 

3. Locate the Orientation attribute column in the window. 

 Make sure that there is a check mark next to Orientation in the 
Attributes menu (in the menu bar). Scroll left or right to find the 
Orientation column. 
 
4. Point to the value to change and push the mouse button. Select 

the new value from the pop-up menu. 
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To Reduce or Enlarge the 
Page Size 

The MacRascol Chooser drivers allow you to adjust your document 
page size to match your images. 
 
The LFR page size is arbitrarily set to about 8 by 12 inches.  For 
example, reducing the image to 90% will allow you to work with an 
8.89-inch high document in your application.  That is, reducing the 
image causes the application to show a larger page size.  Adjusting 
this value can avoid the task of reformatting a document created for 
a different printer. 
 
 
1. Activate the document window in your application. 

 
2. Choose Page Setup… from the File menu. 

 Note that the procedure for bringing up the Page Setup window 
differs for some applications. Verify that the window is titled with the 
name of the driver (e.g., “SCSI LFR Page Setup”). If not, go back to 
the Chooser and select the appropriate MacRascol Chooser driver. 
 

 
 
3. Type in a percentage in the box to reduce or enlarge the image 

(20% to 500%). Click OK. 

 In most applications, the boundaries of the page are now 
adjusted to show the new page size. 
 
 

 

To Adjust the Document 
Resolution 

Some older applications will produce better quality output if 
prompted with the high resolution of the film recorder. You can 
experiment with this by checking the Native Resolution box in the 
Page Setup window. 
 
A few applications will reduce the size of the image when the Native 
Resolution box is checked. In this case, you should leave it 
unchecked. 
 
Most applications are able to communicate properly with the 
MacRascol Chooser drivers, and you will not need to adjust the 
setting of this box. 
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To Adjust the Raster 
Scaling 

MacRascol software lets you match the pixel aspect ratio of an 
image capture device and resample the pixels of a raster image to 
match the resolution of the film recorder. These settings only affect 
the processing of raster files: Targa, TIFF, Photoshop, and Dicomed 
Tile file formats. 
 
 
To Set the Raster Scaling for MacRascol Quick Print 

1. Open MacRascol Quick Print. 

 
2. Choose Page Setup… from the File menu. 

 

 
 
3. Click the Raster Scaling button. 

 The Raster Scale window appears. Adjust the settings in the 
Raster Scale window (see the section below). Raster files printed with 
MacRascol Quick Print will be imaged using the pixel aspect ratio 
chosen. 
 
 
To Set the Raster Scaling in MacRascol Queue Builder 

1. Open MacRascol Queue Builder. 

 
2. Choose Open Preferences from the File menu, or open the 

image queue you want to modify. Select the window. 

3. Locate the Raster Scale attribute column in the window. 

 Make sure that there is a check mark next to Raster Scale in the 
Attributes menu (in the menu bar). Scroll left or right to find the 
Raster Scale column. 

4. Point to the value to change and push the mouse button. Select 
the new value, or Other… from the pop-up menu. 

 
 
 The value for pixel aspect ratio is the first number listed. 

Choosing Other… causes the Raster Scale window to appear. 
Adjust the settings in the Raster Scale window (see the section 
below). The new values for Raster Scale will appear in the list. 
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To Adjust the Raster Scale Window 

 The Raster Scale window: 
 

  
 
1. Type in a new value for Pixel Height:Pixel Width. 

 Some video image capture devices do not sample “square” 
pixels: when viewed on the screen they will appear squashed. You 
can adjust for this with the pixel aspect ratio setting. 
 
 A value equal to 1.0 outputs pixels as square. A value greater 
than one will stretch the vertical dimension of the pixels (and thus the 
image). A value less than one will stretch pixels in the horizontal 
direction. 
 
2. Choose Best fit…, Crop edges…, or Match pixels. 

 Use Best fit of entire image in frame to adjust the size of the 
pixels to the point that the entire image is shown on the film. Some of 
the frame may result empty (filled with the background color). 
 
 Use Crop edges of image to fill frame to adjust the size of the 
pixels until the entire film frame is filled. Some pixels may be “lost” 
outside the frame. 
 
 Use Match pixels of image and frame to avoid adjusting the 
size of the pixels at all. Each pixel of the image is exposed in one 
pixel on the film. The image will fill the frame only if the number of 
pixels in the image exactly matches the resolution selected for the 
exposure. 
 
3. Type in a new value for Additional Scaling. 

 You can adjust the pixels to some other size by choosing an 
Additional Scaling value. 100% will adjust the pixels exactly as 
specified by the Best fit…, Crop edges…, or Match pixels selection. A 
value smaller than 100 makes the image smaller than the selection, 
larger than 100 makes the image bigger than the selection. 
 
4. Click OK. 
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To Crop an Image Cropping allows you to specify exactly which portion of the image is 
to be processed.  The portion of the image you choose will 
automatically be enlarged so as to fill the resulting image as much 
as possible. 
 
! NOTE:  The Cropping window shows only an approximation of 
the finished image.  The resolution and color of the displayed 
image, as well as the color and type of font, may be somewhat 
different from the finished image. 
 
1. Activate a MacRascol Queue Builder image queue window and 

select a PICT or Print image that you want to crop. 

2. Click the Crop Image button, or select Crop Image from the 
Images menu. 

 The image appears in the Cropping window surrounded by a 
selection rectangle.  The selection rectangle defines the 
cropped area. 

 

3. Crop the image by adjusting the selection rectangle. 

 To change the area cropped by the selection rectangle, point 
to an edge of the selection rectangle and drag the edge.   

 To constrain the selection rectangle to the correct aspect 
ratio of the selected film type (slide film is 2:3), hold the shift 
key and drag a corner or a side of the selection rectangle.  If 
you drag a corner, the opposite corner remains anchored.  If 
you drag a side, the opposite side remains anchored. 

 To move the selection rectangle, point inside the selection 
rectangle and drag it.  

 To reset the selection rectangle to the original cropping area, 
check Default Cropping. 

 
 ! NOTE:  The following operations are for viewing purposes 

only and do not affect the cropping of the image. 

 To enlarge the image, check Magnifying Tool.  A rectangle 
representing the borders of the new view appears.  
Crosshairs mark the center of the new view.  Click the center 
of the area you want to enlarge. 

 To reduce the image, click Reduce.  The image and the 
selection rectangle are reduced. 
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Working with Specific Images 
 

This section provides guidelines on how you can enhance specific 
image types. 
 
 
 

 

Working with Fonts MacRascol supports three different font types: Adobe Type 
Manager (ATM) PostScript scalable screen fonts, TrueType 
scalable screen fonts, and Macintosh bitmapped screen fonts.  
Bitmapped screen fonts have jagged edges when output at high 
resolution, whereas scalable fonts look sharp at any size and 
resolution.   
 
The appearance of a font in a MacRascol image depends upon the 
information placed in the image file by the application that created it. 
 

If the application, such as Photoshop, operates on bitmaps, the 
font will appear in the image at the resolution of the bitmap. If you 
want the font to appear sharp, you must create the image at a 
resolution comparable to the resolution of the film recorder 
output. 

If the application, such as Freehand, creates bitmaps for each 
object printed, the font will appear as sharp as the application 
wants to create it. If the image file is saved from the application 
as a PICT file, the fonts will have enough resolution for the 
screen, but not enough for the film recorder. If the image file is 
printed with a MacRascol Chooser driver, then the fonts will have 
the full resolution of the film. 

If the application, such as PowerPoint, saves fonts as objects and 
bitmaps, the font’s appearance will depend on the font itself. If the 
font is a bitmapped screen font, the image of the font will be 
blocky. If the font is scalable, the image of an upright (that is, not 
rotated) font will be sharp. 

 MacRascol is able to rotate any scalable font by 90, 180, or 270 
degrees and it will remain sharp. In addition, it will use ATM to 
rotate PostScript fonts at any other angle. It will not rotate 
TrueType fonts to other angles; it will use the bitmap version 
supplied by the application. Most recently released applications 
will generate an acceptable bitmap when printing to a MacRascol 
driver, but not when saving the image as a PICT file. 

 
To Use ATM Fonts with MacRascol 

MacRascol is compatible with Adobe Type Manager (ATM), which 
means that MacRascol has access to the hundreds of fonts in the 
Adobe Font Library through ATM. 
 
ATM Control Panel Settings: 
While using MacRascol to process images which contain ATM, Set 
ATM to On, set the Font Cache to at least 64K, and select Character 
Shapes under Preserve. 
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To use ATM fonts with MacRascol, simply do the following: 
 
•  Install ATM according to the instructions in the ATM User Guide. 

•  Process images as normal with MacRascol Print Monitor. 

 

To Use TrueType Fonts with MacRascol 

MacRascol is also compatible with Macintosh TrueType fonts, which 
means that MacRascol has access to the many fonts available in 
TrueType form. 
 
To use TrueType fonts with MacRascol, simply do the following: 
•  Install System software and add the desired TrueType fonts into 

the Fonts folder. 

•  Process images as normal with MacRascol Print Monitor. 

 

Deciding If You Need Fine Character Spacing 

Try this test if you are not sure whether an image was created with 
fractional widths: 
 
1. Activate the image queue window in MacRascol Queue Builder 

and select the image you want to test. 

 
2. Click Crop Image. 

 The image is displayed in the Cropping window. 

 
3. Look at the spacing of text in the image. 

 
4. Locate the value for Character Spacing in the image queue. 

 Make sure that Character Spacing is checked in the Attributes 
menu, and scroll right or left until the Character Spacing attribute 
column is visible. 

 
5. Change the value for Character Spacing. 

 
6. View the Cropping window again.   

 Use the setting that seems to display better character spacing in 
the Cropping window. 
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Bitmap Images 
This section describes how to work with images made up of bitmaps.  
Photoshop and scanners create bitmaps. 
 
 
Enhancing Bitmaps 

These are some of the ways you can enhance bitmap images: 
 

 Crop the image 

 
 Invert Black and White 

 If you are preparing a slide that contains large white areas and 
fine black lines, you may want to invert black and white.  Large 
white areas don’t look good when projected from a slide. 

 However, if you are producing an overhead transparency or 
negative film, it’s better if you don’t invert black and white. 

 
 

Bitmaps on a Film Recorder 

These are recommended settings for the slide quality of bitmap 
images: 
 

 Film Recorder Resolution 

 Use the resolution that matches the size of the bitmap. 
Conversely, create the bitmap to match the quality of output you 
want. 

 
 Antialiasing  

 Use none. 

 
 High or Low Contrast Gamma 

 Try high contrast (gamma value of 0.5 or less) for paint 
(computer-generated) images on transparency film. Try low 
contrast (gamma value of 1.0 or greater) for scanned 
(photographic) images. 

 
 

 

Object Images Colors on the screen may look different when output on a film 
recorder. This is because the film recorder works from a much 
larger palette of colors than can be shown on a computer screen. 
 
 
Enhancing Objects 

 Crop the Image 
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 Use Fine Character Spacing if the image contains text that 
implements fractional widths 

 
 Invert Black and White 

 Large white areas don’t look good on slides.  If your image 
contains large white areas and fine black lines, you may want to 
invert it. 

 However, if you’re producing overhead transparencies or 
negative film, don’t invert black and white. 

 Color the Background 

 
 Ignore Patterns 

 This converts the patterns to solid colors, which look better on a 
slide. 

 
 
Color Objects on a Screen 

The Cropping window enables you to preview images.  Because of 
the way the Macintosh displays color, the colors displayed in the 
Cropping window may look very different from the actual colors in 
the image.  However, the image will output with the correct colors. 
 

Objects on a Film Recorder 

 4K (Fine) Resolution or better Resolution depends on the 
requirements of your presentation.  Fine resolution eliminates 
jaggies you may see with Fast resolution. 

 No Antialiasing If there are still noticeable jaggies in the image 
with Fine resolution, you can smooth them out with antialiasing. 
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BLL Images  
A BLL file describes an image to be output on a particular device with 
particular options.  BLL files can be output to their destination device 
through MacRascol Print Monitor on the Macintosh, or WinRascol on 
the PC. 

 

To Convert Your Images to BLL Files with the Macintosh 

Using the MacRascol software, you can convert Macintosh-format 
image files into BLL files. PICTs, scrapbooks, and images printed 
though the Chooser driver, BLL File, with the Print… command can 
be converted to BLL files. HPGL, LL, TIFF, Targa, Photoshop, and 
Dicomed Tile formats are compatible with both PC and Mac software 
and cannot be converted to BLL files. 

 

 Add the files to a queue with MacRascol Queue Builder, or print 
them with BLL File chosen as the driver. 

 Adjust the output options.Once the images have been added to 
a queue, you may adjust all the various output options for those 
images as described in sections “Setting Image Quality,” “Enhancing 
Images in a Queue,” and “Working with Preferences. 

 Process the queue with MacRascol Print Monitor. 

To start the conversion of images to BLL files, follow the instructions 
in the section “Processing Queues for Output” in the Using 
MacRascol chapter.  When the processing has completed, you 
should find the BLL files in the folder you specified with the BLL File 
Setup command.  The files are ready to be transferred to another 
location for imaging on the output device. 
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To Image Your BLL Files with the Macintosh  

 

Some BLL files created with WinRascol software (prior to version 
4) on a PC cannot be imaged by the Macintosh.  If you attempt to 
image these files, you will get error 84, “Cannot rotate raster data 
in BLL file."  Update your WinRascol software to the latest 
version. 

 
 Set the number of copies in the MacRascol Quick Print Copies 

box. 

 
 Print the BLL files with the MacRascol Quick Print Print Files 

command. 

 
 On the system exposing the BLL files to a film recorder, the 

camera type and the film type loaded in the camera must match 
what is specified in the BLL file.  If you are using a custom film 
type (a film type from an LFC file, which is listed below the dotted 
line in the Film Type pop-up menu), the film recorder model also 
must match what is specified in the BLL file.  Failure to follow this 
procedure will result in either incorrect images or error messages 
and no images. 
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To Convert Your Images to BLL Files With a PC 

To use the WinRascol software, refer to the WinRascol User Guide. 
To use the WinBLL software, refer to its electronic documentation. 

 
 

To Image Your BLL Files With a PC 

To use the WinRascol software, refer to the WinRascol User Guide. 
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Moving and Copying Queues 
 

 
It is possible to move a Queue and its image files from one Mac to 
another, from one disk to another, or to a different place on the same 
disk.  
 
Starting with MacRascol 5.2, aliases are internally used to refer to 
files placed in queues. When an image file is placed in a Queue its 
location is stored via an alias record, similar to aliases in the Finder, 
rather than relative to the root of the disk (absolute referencing).  
 
There are two easy ways to make a queue that can be easily moved: 
 
 
Making a Mobile Queue (First way) 

1. Make a special folder that contains all the images you want in 
your queue. 

2. Create the queue in the same folder and add all the images to it. 

3. You can now move the queue by moving the folder. 

 
 
Making a Mobile Queue (Second way) 

1. Make a new queue. 

2. Add all images to the queue with: 

 MacRascol Chooser driver using your application’s Print 
command. Select the queue as the destination. 

 MacRascol Quick Print print files feature. Be sure to check 
the Make temporary copies of these files box. 

 MacRascol Queue Builder add feature. Be sure to check the 
Add a copy of this file box. 

3. You can now move the queue by moving both the queue itself 
and the associated folder called queuename-Images. 
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Processing Queues for Output 
 

The MacRascol Print Monitor processes image queues and outputs 
images on a film recorder.  Processing queues for output entails 
these steps: 
 
 
1. Configure the software with a MacRascol Chooser driver. 

 Refer to the All About Configuration Options section at the 
beginning of this chapter. 

 
2. Select the queue you want to process, and start MacRascol Print 

Monitor. 

 Print directly to the Destination: LFR (or Destination BLL) with a 
MacRascol Chooser driver, or 

 Print files with MacRascol Quick Print, or 

 Select an image queue window in MacRascol Queue Builder and 
press the Process button (or choose Process Queue from the File 
menu). 

 
3. If necessary, restart MacRascol Print Monitor. 

 It may be required to restart MacRascol Print Monitor if there was 
not enough system memory when the queue was selected, or 

 Processing may have been stopped after encountering a film 
recorder error, or 

 It may be necessary to adjust the MacRascol Print Monitor 
installation. 
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Adjusting MacRascol Print 
Monitor Memory 
Requirements 

Processing high-resolution images is a memory-intensive task that 
requires some consideration of how memory is to be used.  
 
Before starting MacRascol Print Monitor, you may need to adjust 
MacRascol Print Monitor’s memory requirements. Up to a point, the 
more memory you allocate to MacRascol Print Monitor, the faster it 
will go. 
 
The memory requirement entries determine how much memory is 
allocated to MacRascol Print Monitor. It is preset at 5120K.  You can 
run MacRascol Print Monitor with as little as 2048K, but performance 
may suffer.  Performance improves when you allocate more memory 
than 3072K, up to about 7168K.  
 
Maximum memory requirements depend on the amount of memory in 
your Macintosh, the size of your System, and what other applications 
are running. Turning virtual memory on is compatible with MacRascol 
Print Monitor, but is not advised when speed is desired. 
 
To change Memory Requirements: 
 
1. Activate the Finder. 

 
2. Choose About This Computer from the Apple menu to determine 

how much memory is available. 

 The information window displays the largest unused block.  This 
is the maximum amount of memory you can allocate to an 
application.  

 
3. Locate the MacRascol Print Monitor icon. 

 MacRascol Print Monitor is installed in the MacRascolQ Data 
folder in your system folder. 

4. Select the MacRascol Print Monitor icon and choose Get Info 
(Memory) from the File menu. 

 The Info window appears. 
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5. Enter the desired Minimum Size and Preferred Size. 

 Allocating up to 7168K improves performance for complex 
images.  

☞☞☞☞  CAUTION:  In many cases, allocating much more than 7168K will 
decrease performance. 

☞☞☞☞  CAUTION:  If you are using virtual memory, never allocate more 
than 75% of the amount of real memory in your system, even if 
you have much more virtual memory available. 

 
6. Close the Info window.  

 
Now you are ready to run MacRascol Print Monitor. 
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Adjusting MacRascol Print 
Monitor Unused Memory 

MacRascol Print Monitor doesn’t use all its available memory for 
processing images.  Some memory is left unused for housekeeping 
and system tasks. 
 
You can adjust the amount of memory left unused after starting 
MacRascol Print Monitor. Either bring it to the front while it is 
running, or locate and start it from the Finder. MacRascol Print 
Monitor is installed in the MacRascolQ Data folder in your system 
folder. 
 
1. Choose Unused Memory from the File menu. 

 A dialog box displays memory options. 

   
 
2. Select the amount of memory you want left unused. 

 Selecting 70K or 200K is optimal for almost all situations. 
 
3. Click OK. 

 
The amount of memory left unused is adjusted immediately, and 
saved for the next time MacRascol Print Monitor runs. 
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Processing the Print 
Queue 

Use the Print Queue when you want to print images immediately 
after creating them, such as when you are taking instant prints with 
your film recorder. You will create new queues when you are using 
MacRascol Queue Builder to construct queues of images. 
 
 
What You Need to Use the Print Queue  

In order to use the Print Queue effectively, you must have enough 
memory to run MacRascol Print Monitor in the background and your 
graphics application in the foreground.  Since your foreground 
process is sharing your Mac with a background process, response 
time will be slower than normal. 
 
 

How to Place Images in the Print Queue 

You can place images in the Print Queue via a MacRascol Chooser 
driver Print command, or with MacRascol Quick Print, or with 
MacRascol Queue Builder when the Print Queue is selected. 
 

☞☞☞☞  CAUTION:  Remember that images will be deleted from the Print 
Queue after successful completion. 
 
 

How to Start the Print Queue 

 

 MacRascol Print Monitor starts processing the Print Queue when 
directed from MacRascol Chooser driver Print command, or from 
MacRascol Quick Print, or from MacRascol Print Monitor when the 
Print Queue is selected. 
 

 

You can also manually direct MacRascol Print Monitor to start 
processing the Print Queue by choosing Process Print Queue from 
the File Menu. 
 
MacRascol Print Monitor will immediately begin processing images 
from the Print Queue. 

 

! NOTE:  MacRascol Print Monitor treats the Print Queue differently 
from all other queues in two important ways: 

 1) When an image in the Print Queue is successfully printed, it is 
deleted from the queue. For all other queues, processed images 
are left in the queue with a status of Done. 

 2) When an image in the Print Queue has caused a processing 
error, processing stops until you decide what to do. For all other 
queues, images causing processing errors are left in the queue 
with a status of Error, and the processing of images continues. 
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Processing Other Image 
Queues 

MacRascol Print Monitor automatically processes the queue 
selected by MacRascol Queue Builder. 

 

You can also manually direct MacRascol Print Monitor to start 
processing another image queue by choosing Process Image 
Queue… or Start Print Queue from the File Menu. 
 
The bottom line of the MacRascol Print Monitor window display 
changes to reflect the current queue: 
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To Monitor Processing 
with MacRascol Queue 
Builder 

You can monitor the status of the queue as MacRascol Print 
Monitor is processing it. 

1. While MacRascol Print Monitor is processing a queue, select 
Open command from the File Menu. 

 MacRascol Queue Builder will open a window with the image 
queue being processed. 

2. Move the MacRascol Queue Builder and MacRascol Print 
Monitor windows until both are visible on the screen. 

 To move a window, point to the window title bar and drag the 
window to where you want it. 

3. Watch the Status column in the image queue window to see the 
status of each image being processed. 

 If the Status column is not visible, make sure that it is checked 
in the Attributes menu and scroll left or right until it is visible. 

 Status messages that may appear include: 

Done—the image has been processed. 

Hold—the image will be skipped. 

Printing—the image is being processed. 

Error—an error prevented the image from being processed. 
The next section describes how to view an error message. 

 

 
 
To Display an Error Message in MacRascol Queue 
Builder  

You can display an error message if the image’s status in the image 
queue window reads Error (followed by an error code). 
 
1. Activate the image queue window and locate the Status attribute 

column. 

 Make sure that the Status is checked in the Attribute menu. Scroll 
left or right to find the Status column. 

2. Position the pointer over the word “Error” in the Status column 
and pop-up the Status menu. 

 
 
 
3. Select Error from the Status menu. 

 A window appears with the text of the error message. 
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Dropbox Operation 
 

MacRascol Quick Print can be set up to monitor a folder for image 
files and automatically print them. 
 

 

Dropbox Setup MacRascol Quick Print needs to be configured once before using 
the dropbox.  
 
1. Configure the software with a MacRascol Chooser driver. 

 Refer to the All About Configuration Options section at the 
beginning of this chapter. 

 
2. Select "Page Setup…" from the File menu of MacRascol Quick 

Print and set the printing options for the image files. 

 
3. Select "Select Dropbox…" from the Dropbox menu of MacRascol 

Quick Print and select the folder to use as the dropbox. 

 
4. Check the "Enable Dropbox" in the Dropbox menu of MacRascol 

Quick Print. If there is no checkmark on "Enable Dropbox", then 
select it. 

 MacRascol Quick Print will periodically check the dropbox folder 
for image files and start printing them. 
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Using a Dropbox  MacRascol Quick Print watches the dropbox folder for images to 
print. When it finds recognizable image files, they are moved to the 
Print Queue and deleted from the folder. MacRascol Print Monitor 
starts sending them to the film recorder. 
 
If you want files sent from other Macintosh computers, you can 
enable sharing for the dropbox folder. On other Macs, mount the 
dropbox folder with AppleShare in the Chooser. After image files are 
copied into the dropbox folder, the host Macintosh will image them. 
 
You can also select a dropbox folder on another computer or a file 
server computer. MacRascol Quick Print moves the “dropped” 
image files to the Print Queue on it's own Macintosh disk before 
they are printed. You can use this strategy to automatically image 
BLL files placed on the file server by the WinRascol BLL driver. 
 
The dropbox operates only as long as MacRascol Quick Print is 
running. If you want to automatically start the dropbox when the 
Mac is powered on, move MacRascol Quick Print (or an alias of it) 
to the Startup Items folder of the system folder. MacRascol Quick 
Print remembers all of its settings, including whether the dropbox 
was enabled. 
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Server Operation 
 

The MacRascol Server receives images from MacRascol software 
running on other Macintosh computers and outputs images on a film 
recorder. 
 

 

Terminology  Server Mac The Macintosh on which MacRascol Server is 
running. 

Server MacRascol Server 

Client Mac A Macintosh on which MacRascol client software is 
running. 

Client MacRascol Print Monitor  
 

 

Modes of Operation  Before using MacRascol Server, you should understand its three 
basic modes of operation: Inactive, Waiting for Request, and 
Serving Client.  
 
 

 
 
Inactive: The Server must be in this mode in order for you to 
change the settings in the File menu. It will not appear in the clients' 
list of available servers, or accept requests from clients, until you hit 
the Start button and enter Waiting for Request mode. 
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Waiting for Request:  in this mode, the Server name will appear in 
the clients' list of available servers, and the Server can accept 
requests from clients. As soon as a client connects, the name of the 
client will be displayed and the Server will enter Serving Client 
mode. If you hit the Abort button, the Server will become Inactive. 
 
 

 
 
Serving Client: In this mode, the Server accepts data from the 
client, decodes it and transmits it to the output device. The Server 
name will appear in the other clients' list of available servers, but it 
will not accept requests from other clients. A client trying to connect 
will wait until the Server has finished with the current client and has 
returned to Waiting for Request mode. If you hit the Stop button, the 
Server will become Inactive after the client's current image is 
finished. If you hit the Abort button, the Server will become Inactive 
immediately. 
 
 



 Server Operation                99 

 

Launching MacRascol 
Server  

Before the first time MacRascol Server is launched, open the 
Chooser (from the Apple menu) and select the SCSI LFR driver in 
the list on the left. Then select the film recorder from the list on the 
right. This will set the SCSI Bus and ID address for MacRascol 
Server to use to communicate with the film recorder. Setting the 
address this way is only required once. SCSI LFR need not be the 
current Chooser driver when MacRascol Server is used. 
 
Do not print with the SCSI LFR driver while MacRascol Server is 
serving another computer. Both programs will try to use the LFR at 
the same time, with undesired results. 
 
When MacRascol Server is launched, it automatically enters the 
Waiting for Request mode. The very first time you launch the 
Server, you should hit the Abort button to become Inactive, and 
verify all the settings in the File Menu, and then hit the Start button. 
The settings are saved so you don't have to do it again until you 
want to make a change. 
 
If you always want MacRascol Server to be available on the 
network, move it to the folder called Startup Items inside the System 
Folder. MacRascol Server will start to run whenever the Server Mac 
is powered up or restarts. 
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Reservations  Normally, MacRascol Server returns to Waiting for Request mode 
while the client is pre-processing the next image so that other 
clients have a chance to connect. If you do not want images from 
different clients to be interspersed, but rather wish to allow each 
client to finish all his images before another client begins, you may 
use the reservation feature. 
 
When reservations are used, MacRascol Server will only accept 
requests from the reserved client for one minute after the reserved 
client has disconnected. This blocks other clients from connecting 
between images, and automatically turns the reserve off one minute 
after the reserved client has stopped sending images.  
 
Note: If you stop the client (to change Image Queues, for example) 
for more than one minute, you will lose your reservation and if 
another client is waiting, it will connect to the Server. 
 
The reservation feature can be enabled either in MacRascol Server 
or in the LFR Server driver. If Automatic Reserve is enabled in the 
server, every client that connects is reserved. Automatic Reserve in 
MacRascol Server takes precedence over the Reserve option in the 
LFR Server driver. If Automatic Reserve is not enabled, each client 
can decide individually if he wants to reserve by using the Reserve 
option in the LFR Server driver. 
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Header Image  If Automatic Reserve is enabled in MacRascol Server, the Header 
Image option becomes available. If Header Image is checked, an 
image displaying the Client name, Server name, time and date will 
be printed before each new client's batch of images. If the output 
device is a film recorder, the text will be light gray and the 
background will be black.  
 

Client: 
Server: 
Time: 
Date:

CharlieBrown 
Lasergraphics 
1:38 PM 
Friday, June 15, 1990
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MacRascol Chooser 
Driver Reference 

 

 
This chapter describes the MacRascol Chooser driver windows and 
commands. 
 
The MacRascol Chooser drivers, SCSI LFR, AppleTalk LFR, LFR 
Server, and BLL File let you print images for the film recorder from an 
application using the Print command.  
 
“The Chooser” outlines how to bring up the Chooser, select a driver, 
and set the configuration. 
 
“The Page Setup Window” outlines how to adjust the page size of a 
document using the options on the Page Setup window prior to 
printing. 
 
“The Print Window” outlines how to print pages and explains the 
parameters on the Print window. 
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The Chooser 
 

The Chooser is used to select the current printing device. The 
Chooser is often used to select a driver before a document is 
created so that the Page Setup window will reflect the page 
boundaries of the device. 
 
Select Chooser from the Apple menu.  When the Chooser window 
appears, select the driver from the list on the left side of the window. 
 

LFR Drivers SCSI LFR 

 The device’s name and SCSI address will appear in the list in the 
upper right section of the window. 

 
AppleTalk LFR 

 The film recorder’s AppleTalk name will appear in the list in the 
upper right section of the window. 

 
LFR Server 

 The server’s name will appear in the list in the upper right section 
of the window. 

 

 
 

Select SCSI LFR  

Select AppleTalk LFR  

Select LFR Server  

 Locate the film recorder you wish to use in this list. If necessary, 
use the scroll bar to advance the list. If the AppleTalk LFR or the 
LFR Server are in a different AppleTalk zone, you will have to 
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select the zone desired from a list in the lower left corner of the 
window. Click to select your device. 

 
Get Info  

 If you double-click the film recorder in the list or select it and click 
the Get Info button, a window appears showing some 
characteristics of the device chosen: 
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Manual Setup…  

 Clicking this button brings up a window showing the resulting 
configuration of the software: 

 

 

 

 
 

SCSI Bus & ID  

 Pop up these menus to manually configure or change the SCSI 
address. 

 
Server Name  

 Type in this box to manually configure or change the AppleTalk 
server name or the Lasergraphics Server name. 

 
Film Recorder  

 Pop up this menu to manually configure or change the LFR type. 

 
Use RISC Rascol or Internal Rascol.  

 Check this box to use the hardware Rascol rasterizer. Do not 
check it if your configuration does not include one. 

 
Reserve server between images.  
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 Check this box to prevent other computers on the network from 
using the server while you are printing your batch of images. 

 

After you have selected the device, close the Chooser desk 
accessory to complete the driver selection procedure. You are now 
ready to use the Page Setup and Print commands from your 
application to image film. 
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 To make BLL files, select BLL File from the Chooser window. 

The Setup… button appears on the right side. 

 

 
 

BLL Driver BLL File 
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Setup… 

 Clicking this button brings up a window showing the configuration 
of the BLL File driver: 

 
 
Use DOS compatible filenames 

 Click this check box if the generated BLL files will be used on an 
IBM® PC compatible.  When the box is checked MacRascol 
generates BLL files with legal DOS filenames, which are made 
up of one to eight characters followed by a period and the three-
letter extension “BLL.” 

 
Film Recorder  

 Pop up this menu to set the LFR type in your configuration. 
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New Folder 

 Click this button to create a new folder inside the currently 
displayed folder. Type a new folder name and click Create. 

 
 
Select “folder name” 

 Click this button to save the currently selected folder as the BLL 
output folder. 

 
Cancel 

 Click this button to discard the changes, if any, you have made in 
this window. 

 
 
After you have set up the BLL File driver, close the Chooser to 
complete the driver selection procedure. You are now ready to use 
the Page Setup and Print commands from your application to make 
BLL files. 
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The Page Setup Window 
 

The Page Setup window affects the page size shown by the 
application. This window is often used when a document is first 
created to set the page boundaries. If the document was previously 
created for a different device, use the Page Setup window prior to 
printing. 
 
Select Page Setup… from the File menu of your application. Note 
that the procedure for bringing up the Page Setup window differs for 
some applications. Verify that the window is titled with the name of 
the driver (e.g., “SCSI LFR Page Setup”). If not, go back to the 
Chooser and select the appropriate driver. 
 

 
 
Reduce or Enlarge  

 Type in a percentage in the box to reduce or enlarge the image 
(20% to 500%).  Use this to adjust the page size to match your 
images.  The LFR page size is arbitrarily set to about 12 by 8 
inches.  For example, reducing the image to 90% will allow you to 
work with an 8.89-inch wide document in your application.  That 
is, reducing the image causes the application to show a larger 
page size.  Adjusting this value can avoid the task of reformatting 
a document created for a different printer.  The dimensions of the 
page at 100% are set to the actual printable area of the selected 
printer. 

 
Orientation  

 Click on one of the icons to select either “portrait” or “landscape.”  
Some applications only allow one of these selections. 

 
Native Resolution  

 Check to request high-resolution output from your application.  
For certain applications this option is preset and cannot be 
changed.  It will appear grayed out if this is the case.  For other 
applications it will reflect its previous setting from the last time it 
was changed from that application.  Change the setting only if the 
output is low quality.  It may or may not improve the output. 

 
Blend Patterns?  

 Check this box to cause all patterned objects printed by the 
application to be replaced with a color that is a blend of the 
colored dots of the pattern. 
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Invert Black and White?  

 Check this box to cause all black objects printed by the 
application to be replaced with white and all white objects 
replaced with black. 

 
Background Color  

 Pop up this box to change the color printed behind the application 
image. This color will be visible if the application does not draw to 
the edges of the page, or it leaves holes between the objects that 
it draws. Sometimes an application will assume it is drawing on 
white paper and not paint the white portions of the image. In this 
case, you should set the background color to white. 

 
Camera Options and Color Balance 

 Click these buttons to set film exposure, color balance, and 
gamma parameters. See the following sections. 

 
Save as Default  

 Click this button to save the Page Setup as the initial settings for 
new documents. 

 
! NOTE:  Additional items may be added to the Page Setup window 
by the application. Refer to your application’s documentation for 
details. 
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Camera Options... Displays a dialog box that lets you specify what film is being used 

and set options affecting slide quality. 
 

 
 

Film Type 

 Set this to the type of film loaded in the camera back. 

 Film types listed in the second section of the Film Type menu 
come from Lasergraphics Film Calibration (LFC) files stored in 
the MacRascolQ Data folder inside your system folder. 

 
Resolution 

 Set this to the pixel resolution desired. 

 Fast (2K) resolution produces 2000-line slides (2048 by 1365 
pixels).  Fine (4K) resolution produces 4000-line slides (4096 by 
2731 pixels).  Extra Fine (8K) resolution produces 8000-line 
slides (8192 by 5461 pixels). Ultra Fine (16K) resolution 
produces 16000-line slides (16384 by 10922 pixels). 

 The “Working With Specific Images” section of the Using 
MacRascol chapter describes which setting to use for specific 
images. 

 
Antialiasing 

 Set this to the antialiasing level desired. 

 Antialiasing is seldom useful for film recorders, especially when 
exposing at higher resolutions.  However, Level 1 antialiasing 
may produce smoother edges and lettering in images. Level 2 
antialiasing is a more intense version of Level 1. Note that 
antialiasing increases processing time significantly.   

 
Minimum Exposure Time 

 This option allows you to match the timing of your film recorder to 
the MacRascol rasterizer. Doing this eliminates periodic faint 
horizontal lines that sometimes appear when the film recorder is 
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forced to wait for data from the rasterizer. If you prefer, you may 
eliminate this problem by adding more memory to your film 
recorder. 

 Recent Lasergraphics film recorders will automatically adapt to 
virtually any data rate. It is highly likely you will never have to use 
this option. 

 Click Fastest Possible if there are no periodic faint horizontal 
lines, and you are satisfied with the output slides. Click Minutes if 
periodic faint horizontal lines exist. Then type the minimum 
exposure time in minutes (e.g. 5.5) in the box. This will be the 
fastest possible exposure time for this image. It may take longer. 
As an initial value, multiply the normal imaging time by 1 1/2 and 
use that as the minimum exposure time. If the lines still exist, try 
a factor of 2, and so on until they disappear. 

 
Color Balance 

 The current color balance values for Red, Green, and Blue are 
shown here along with the current Gamma value. To change any 
of color balance values, click Set. Clicking Set displays a dialog 
box that lets you set the Brightness, adjust the balance of Red, 
Green, and Blue, and enter the Gamma value. See the following 
section for a detailed description of the film recorder Color 
Balance window. 
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Color Balance  Displays a dialog box that lets you adjust the balance of the three 
film recorder colors: Red, Green, and Blue, and also lets you 
change the Contrast Gamma value. 
 

 
 
Normally, Brightness, Red, Green, and Blue are set at 100%.  
Since color perception is subjective, this dialog box lets you adjust 
the film recorder’s color balance to match your taste.   
 
Increasing the amount of a given color causes that color to be more 
prominent than the other two.  For example, if you increase Blue, 
your images will have a bluish cast.   
 
Decreasing the amount of a color causes the other two colors to be 
more prominent.  For example, if you decrease the amount of Blue, 
your images will look more yellow.  This is because decreasing Blue 
is like increasing Red and Green, which combine to form yellow. 
 
Doubling a color’s value results in twice as much of that color in your 
images.  However, since Color Balance is intended for making slight 
changes in overall color and not for improving poor images, you 
should normally restrict all changes to the range 80–120%. 
 
You may adjust all three colors together by changing the Brightness  
value.  This has the effect of changing the overall brightness of the 
image without changing the color balance.  The range of the 
Brightness setting is restricted depending on the settings of Red, 
Green, and Blue. 
 
The Contrast Gamma adjustment allows you to adjust the contrast of 
the output image through a nonlinear function. 
You may set the value of Gamma in the range of 1/7 to 7 (0.14 to 
7.00), although useful values are usually between 0.25 and 2.00.  By 
adjusting Gamma you can affect the midtones of the image without 
affecting the highlights.  When Gamma is between 1/7 and 1, output 
midtones are darker.   When Gamma is between 1 and 7, output 
midtones are lighter.  Lower values of Gamma produce higher 
contrast output images, and higher values of Gamma produce lower 
contrast output images.   
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When Gamma is 1, the gray mapping is linear, and output images 
have a “flat” contrast.  However, most images look best at a Gamma 
between 0.5 and 0.7. 
 
The graph displayed in the window shows how input intensity values 
are mapped to output intensities.  The horizontal axis increases from 
left to right and represents pixel brightness IN. The vertical axis 
increases from bottom to top and represents adjusted pixel 
brightness OUT. 
 
Note that many other factors affect the final color you see on the film: 
the film manufacturer, the type and age of the film, and the 
equipment, chemicals, and experience of the film developer. 
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The Print Window 
 

The Print window controls the parameters that describe the printing 
process. This window is used to extract the images of the document 
and place them in the queue. 
 
Select Print… from the File menu of your application. Note that the 
procedure for bringing up the Print window differs for some 
applications. Verify that the window is titled “Lasergraphics”. If not, go 
back to the Chooser and select a MacRascol driver. 
 

 

 
 
 
Copies: 

 Type the number of copies of each page you want in this box. 
This option is not available in the BLL File driver. 

 
Pages: 

 Click All if you want all pages of the document to be printed, or 
click From and enter a page range to be printed. 

 
Print: Color/Grayscale 

 Click for the full-color (24-bit color) image capture mode of the 
driver. Generally, Color/Grayscale is preferred unless the 
Macintosh or the application does not support full color mode. 

 
Print: Black & White 

 Click for the old 8-color image capture mode of the driver. 
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Destination: 

 Push on the Destination pop-up menu to select the destination of 
the images printed. This option is not available in the BLL File 
driver. 

 
 Select “Direct to LFR” if you want the images to be spooled and 

printed immediately. 

 
 Select the last used image queue name to have the images 

saved into an image queue instead of being printed. The driver 
saves the page setup options with the image in the queue, for 
later manipulation by MacRascol Queue Builder. 

 
 Select New Image Queue… to create a new image queue to 

receive the images. 

 
 Select Other Image Queue… to change the image queue that 

receives the images. 

 
!NOTE:  Additional items may be added to the Print window by the 
application.  Refer to your application’s documentation for details. 
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MacRascol Quick 
Print Reference 

 

 
This chapter describes MacRascol Quick Print windows, menus, and 
commands. 
 
MacRascol Quick Print lets you print images of many different file 
formats with an LFR driver. 
 
The first section, “Menus and Commands” describes the 
MacRascol Quick Print menus and commands. 
 
“Finder Operation” describes features of one-step printing from the 
finder. 
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Menus and Commands 
 

This section describes the MacRascol Quick Print menus and 
commands. 
 
 

 

The File Menu 

 

File menu commands enable you 
to set printing options, designate 
files to print, and quit MacRascol 
Quick Print. 

 
 

Page Setup… Displays a dialog box that lets you set the printing options. Before 
using this item, you must select a MacRascol driver in the Chooser. 
 

 
 
Copies 

 Type the number of copies of each image you want in this box. 

 This option is not available when making BLL files using the BLL 
File driver. 

 
Orientation  

 Click on one of the icons to select either “portrait,” “landscape,” or 
“automatic.” 

 This option applies to PICT images, images printed from a 
MacRascol driver, and images from clipboards, scrapbooks, or 
clipping files. 

 
Fine Character Spacing  

 Check Fine Character Spacing if the application that created the 
PICT image uses fractional widths. Usually this option should be 
checked. 
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Blend Patterns  

 Check this box to cause all patterned objects in the PICT image 
to be replaced with a color that is a blend of the colored dots of 
the pattern. 

 
Invert Black and White?  

 Check this box to cause all black objects in the PICT image to be 
replaced with white and all white objects replaced with black. 

 
Background Color  

 Pop up this box to change the color printed behind the image. 
This color will be visible if the image has a different shape than 
the film frame, or if it has holes between the objects. Sometimes 
an application will assume it is drawing on white paper and not 
paint the white portions of the image. In this case, you should set 
the background color to white. 

 
Camera Options 

 Click this button to set film exposure parameters. See the 
Camera Options section in the MacRascol Driver Reference 
chapter. 

 
Color Balance 

 Click this button to set color balance and gamma. See the Color 
Balance section in the MacRascol Driver Reference chapter. 

 
Raster Scaling 

 Click this button to set scaling parameters for raster image files 
(TIFF, Targa, and Photoshop formats). See the Raster Scaling 
section later in this chapter. 

 This option is not available when the BLL File driver is chosen 
because this driver does not process raster files. 

 
Pen Colors 

 Click this button to set extra parameters for HPGL image files. 
See the Pen Colors section later in this chapter. 

 This option is not available when the BLL File driver is chosen 
because this driver does not process HPGL files. 

 
 

Print Files…  Displays a dialog box that lets you select multiple files to print. 
Before using this item, you must select a MacRascol driver in 
the Chooser. You may select files from different directories and 
volumes and add them to a list.   
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File Type 

 Click and hold this menu to select the type of image you want to 
add to print. The list of files will show images of the type you have 
selected. Select “All” to show all file types. 

 
Add 

 Adds the selected image to the list of files to print. You may also 
achieve this by double clicking on the image. 

 
Add all 

 Adds all the images in the current directory list to the Files to 
print list. 

 
Remove 

 Removes the selected image from the Files to print list. 

 
Make temporary copies of these files 

 If you want copies of the images made before being printed, 
check this box. You might want do this to speed up printing if the 
images are not on your local disk, but are on a floppy disk, a slow 
network, or an external hard drive that is slower than your local 
disk. 

 
Print 

 Spools the images in the list of Files to Print to the Print Queue. 
MacRascol Print Monitor will run in the background to process 
and print these images. 

 
 

Print Clipboard If the Clipboard contains a PICT image, the Print Clipboard 
command prints it. 
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Open Print Queue MacRascol Queue Builder opens a window showing the Print 

Queue. 
 
 

Quit Exits the MacRascol Quick Print application. 
 

 
 

The Dropbox Menu Dropbox menu commands enable 
you to control the Dropbox 
features of MacRascol Quick 
Print. 

 
 

Select Dropbox… Displays a dialog box that lets you select the folder to use as the 
Dropbox location. 
 

 
 
New Folder 

 Click this button to create a new folder inside the currently 
displayed folder. Type a new folder name and click Create. 

  
 
Select “folder name” 

 Click this button to select the folder as the dropbox location. 

 
 

Enable Dropbox Select this menu item to enable or disable dropbox watching. When 
this menu item has a checkmark, then MacRascol Quick Print is 
currently watching the dropbox folder for image files to print. 
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Open Dropbox The Finder opens a window showing the contents of the selected 
dropbox folder. 
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Raster Scaling Displays a dialog box that lets you set the raster scaling 
parameters, which change the size and shape of a Targa, TIFF, or 
Photoshop image on film. 
 

 
 
Pixel Height:Pixel Width 

 Changes the pixel aspect ratio for the image. A value of 1.0 
specifies normal, square pixels. Any other value will stretch or 
distort the image. 

 Video capture cards often have pixel aspect ratios other than 1:1. 
You can set this value to match the card’s characteristics so that 
the final image on the film matches the original image. 

 When changing the aspect ratio of the pixels, note that the aspect 
ratio of the entire image is affected. For example to stretch the 
width of an image sized for a computer screen (3:4 aspect ratio) 
to fill a slide (2:3 aspect ratio), use a value of (2/3)/(3/4) = 0.889. 

 
Best fit of entire image in frame. 

 Click this option to fit the entire image in the slide frame. The 
image will be scaled so that all the pixels of the file are shown in 
the output. If the image is taller than the film frame, borders will 
appear on the sides. If the image is wider than the film frame, 
borders will appear on the top and bottom. These borders will be 
colored with the Background Color set in the Page Setup window. 

 This scaling to fit the frame is done after the Pixel Height:Pixel 
Width value modifies the aspect ratio of the image. 

 
Crop edges of image to fill frame. 

 Click this option to fill the slide frame with the image. The image 
will be scaled so that there are no borders in the output. If the 
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image is taller than the film frame, some of the top and bottom 
will be cropped off. If the image is wider than the film frame, some 
of the sides will be cropped off. 

 This scaling to fill the frame is done after the Pixel Height:Pixel 
Width value modifies the aspect ratio of the image. 

 
Match pixels of image and frame. 

 Click this option to map the pixels of the image one-to-one with 
the pixels on the film. The image will not be scaled at all. If there 
are more pixels in the image than the selected film resolution, 
then the edges of the image will be cropped off. If there are fewer 
pixels in the image than the selected resolution, borders will 
appear around the picture. Note that changing the resolution 
setting will change the size of the picture on the film. 

 This scaling to fill the frame is done after the Pixel Height:Pixel 
Width value modifies the aspect ratio of the image. If the value is 
not 1.0, then the vertical pixels are matched, and the horizontal 
pixels are scaled to the proper aspect ratio. 

 
Additional Scaling 

 Use this option to scale the image to some other size in the film 
frame. 100% is the normal value. The center of the image will 
always be placed in the center of the film frame. 

 This additional scaling is done after the Pixel Height:Pixel Width 
value and the Best fit/Crop edges/Match pixels selection modifies 
the image size. 

 If the value of Pixel Height:Pixel Width is not 1.0 and Match pixels 
is selected, you can use Additional Scaling to match the 
horizontal pixels (and scale the vertical pixels). To accomplish 
this, select a value for Additional Scaling that is 100x the value 
chosen for Pixel Height:Pixel Width. 
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Pen Colors Displays a dialog box that lets you set the HPGL Pen Colors,  Pen 
Thickness, and Plotter Model. 
 

 
 
Pen Color Defines the colors of the 8 plotter pens.  The preset pen 

colors are shown in the figure above. 

 Pop-up menus let you change the color of each pen. 

 
Pen Thickness 

 Defines the pen thickness in HPGL images.  The preset thickness 
is Default, which should be satisfactory most of the time. 

 A pop-up menu lets you change the pen thickness. 

 
Plotter Model Defines the model of the plotter to emulate.  The 

preset model is the HP 7475A. 

 A pop-up menu lets you change the plotter model. 

 
 



128           MacRascol Quick Print Reference 

Finder Operation 
 

MacRascol Quick Print will print image files directly from the Finder. 
Before using this feature, you must select a MacRascol driver in the 
Chooser. 
 
Dragging Image Files Select the image files to be printed. 

Drag them to the MacRascol Quick Print icon. The icon will 
highlight. Release the mouse button and the files will be spooled 
to the Print Queue. MacRascol Print Monitor will run in the 
background to process and print them. 

 MacRascol Quick Print need not be running for this to work. If it is 
not running, it will start long enough to do its work and then quit 
immediately. 

 
Option key If you hold down the option key when releasing the 

mouse button, then the MacRascol Quick Print will make 
temporary copies of the files before spooling them. 

 
Command key If you hold down the command key when 

releasing the mouse button, then the MacRascol Quick Print 
Page Setup window will show before the images are spooled. 
You can change any processing option at this point. 

 If you do not show the Page Setup window, MacRascol Quick 
Print will use the processing options set up the last time the 
window was open. 
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MacRascol Queue 
Builder Reference 

 

 
This chapter describes MacRascol Queue Builder windows, menus, 
and commands. 
 
MacRascol Queue Builder lets you organize images into groups 
called queues and to enhance the images for processing as high-
resolution color output. 
 
The first section, “Menus and Commands,” describes the 
MacRascol Queue Builder menus and commands. 
 
“The Preferences Window” describes the components of the 
preference list window. 
 
“Image Queue Windows” describes the components of image 
queue windows. 
 
“Processing Options” describes the Attributes and Values of the 
Preferences and Image Queue windows. 
 
“The Cropping Window” describes the components of the PICT 
cropping window. 
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Menus and Commands 
 

This section describes the MacRascol Queue Builder menus and 
commands. 
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The File Menu  File menu commands 
enable you to open a queue 
for modification, process a 
queue with the MacRascol 
Print Monitor, and quit 
MacRascol Queue Builder. 

 
 

New Image Queue… Displays a dialog box that lets you create a new image queue. 
 
 
 
See the “Image Queue Windows” section later in this chapter. 
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Open Image Queue… Displays a dialog box that lets you open an existing image queue. 

 
Open Enclosing Folder… Displays the selected item in the Finder, à-la-Sherlock. 

 
 
See the “Image Queue Windows” section later in this chapter. 
 
 

Open Print Queue Opens a special image queue that is used for immediate printing by 
the MacRascol drivers and MacRascol Quick Print. You can 
manipulate it like other queues, but MacRascol Print Monitor treats 
it specially. Unlike regular queues, image entries are deleted from 
the Print Queue once they have been successfully completed. See 
the subsection titled “To Begin Processing the Print Queue” in the 
section “Processing Queues for Output” in the Using MacRascol 
chapter for more details about using the Print Queue. 
 
 

Open Preferences Opens the window that lists preferences and their attribute values. 
See “The Preferences Window” section later in this chapter. 
 
 

Close Closes the frontmost window. 
 
 

Process Queue Causes MacRascol Print Monitor to start up in the background and 
process the queue displayed in the frontmost window. This menu 
command is also available as a button in the image queue window. 
 
 

Quit Exits MacRascol Queue Builder. 
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The Edit Menu Edit menu commands enable you 
to select and move line items in 
image queues and in the 
preference list. 

 
 

Cut 
The selected line items in the front most image queue window or 
preference window are cut to the clipboard. 
 
 

Copy 
The selected line items in the front most image queue window or 
preference window are copied to the clipboard. 
 
 

Paste 
If the clipboard contains a PICT image and the frontmost window is 
an image queue window, the image is added to the end of the queue. 
The processing options from the topmost item in the preference list 
are copied. 
 
If the clipboard contains line items from an image queue and the 
frontmost window is an image queue window, the line items are 
added to the end of the queue. 
 
If the clipboard contains line items from the preference list and the 
frontmost window is the preference window, then the line items are 
added to the end of the preference list. 
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The New Preference Name window appears for each item so that it 
can be renamed: 
 

 
 
If the clipboard contains line items from an image queue and the 
frontmost window is the preference list, then the processing options 
from each of the items are added to the end of the preference list. 
The New Preference Name window appears for each item so that it 
can be renamed. 
 
 

Clear 
The selected line items in the front most image queue window or 
preference window are deleted. 
 
 

Select All 
All the line items in the front most image queue window or preference 
window are selected. 
 
 

Duplicate 
The selected line items in the front most image queue window or 
preference window are copied to the end of the list. 
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The Images Menu  Images menu commands enable 
you to add and delete line items in 
image queues  
 
These menu commands are also 
available as buttons in the image 
queue window. 

 
 

Add Image… 
Displays a dialog box that lets you add a file to the queue. 
 

 
 
File Type 

 Click and hold this menu to select the type of image you want to 
add to the queue.  The list of files will show images of the type 
you have selected. 

 
Add the copy of this file 

 If you want a copy of the image made and added to the queue, 
check this box.  You should do this if the image is not on your 
local disk, but is on a floppy disk, a network, or an external hard 
drive that may not always be available.  You may also wish to use 
this feature if you intend to move the queue and its images later. 

 
Add 

 Click Add to add the selected image to the queue. The 
processing options from the topmost item in the preference list 
are copied. 

 
 

Add Many… 
Displays a dialog box that lets you select multiple files to add to the 
image queue. You may select files from different directories and 
volumes and add them to a list. 
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File Type 

 Click and hold this menu to select the type of image you want to 
add to the queue.  The list of files will show images of the type 
you have selected. 

 
Add 

 Adds the selected image to the list of files to open.  You may also 
achieve this by double clicking on the image. 

 
Add all 

 Adds all the images in the current directory list to the Files to 
open list. 

 
Remove 

 Removes the selected image from the Files to open list. 

 
Add the copies of these files 

 Click this check box if you want copies of the images made and 
added to the queue.  You should do this if the images are not on 
your local disk, but are on a floppy disk, a network, or an external 
hard drive that may not always be available.  You may also wish 
to use this feature if you intend to move the queue and its images 
later. 

 
Done 

 Adds the images in the list of files to open to the queue. The 
processing options from the topmost item in the preference list 
are copied. 
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Delete Image 
Deletes the selected image(s) from the queue in the frontmost 
window. This button is dimmed unless an image is selected. 
 
  ☞☞☞☞  CAUTION:  When you click Delete Image, the selected image 

is deleted immediately.   

 
 

Crop Image 
Opens (or brings to the front) the cropping window. See the 
“Cropping Window” section later in this chapter for details of its 
operation. 
 
This menu item will be dim unless there is one image selected in the 
frontmost window and the file type of that image is PICT or Print. 
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The Attributes Menu 

 

Attributes menu commands 
enable you to control which 
attributes are listed in the 
columns of image queues and 
the preference list. 
 
The attributes listed in the menu 
with checkmarks are shown in 
the front most image queue or 
preference list. Selecting an 
unchecked item from the menu 
adds the attribute column to the 
right side of the frontmost 
window. Selecting a checked 
item deletes that attribute 
column from the frontmost 
window. 
 
If an attribute is not applicable to 
the frontmost window, its menu 
entry is dimmed. 

 
 
 
 

The Window Menu  The Window menu lists the 
windows visible in the 
MacRascol Queue Builder. 
Select the desired window from 
the menu to bring it to the front. 
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The Preferences Window 
 

The Preferences window enables you to create and modify sets of 
processing options and give the sets convenient names. To view the 
Preferences window, select Open Preferences from the File menu. 
 
 
 
The Preferences window lists the saved sets of processing options 
called Preferences. 
 
Scrolling 

 If there are more preferences than fit in the window, you can 
change the window height or use the right-hand scroll bar to 
scroll through the list. If more attribute columns are active in the 
window than will fit, you can change the window width or use the 
lower scroll bar to scroll across the matrix. 

 
Preferences 

 The first column lists the names of the preferences. To select a 
preference, click on the name. To select more than one, hold 
down the command key and click or drag through the 
Preferences column. To select a contiguous range, use the shift 
key. To change the order of preferences in the list, drag the 
selected preference name(s) up or down the list to a new 
location. 

 Clicking on the title of the first column (Preferences) will 
alternately deselect and select all items in the list. 

 
Edit Menu 

 The Edit menu may be used to operate on the list. You can cut, 
copy, clear, or duplicate the selected items. You can paste 
preference items from the clipboard. Use Select All to select all 
items in the list. 

 
Attributes 

 The rest of the columns list the attribute values for each 
preference. Use the Attributes menu to control which attribute 
columns are included in the window. To select a column, click on 
the title at the top. To select more than one, hold down the shift 
key and click or drag across the title row. To change the order of 
the attributes, drag the selected title(s) left or right to a new 
location. 

 To alter the width of the Preferences column or an attribute 
column, point to the right-hand edge of the column in the title 
(top) row. Drag the column edge to the left to shrink, or right to 
widen the column width. 
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Values 

 To change an attribute value, point to it and push the mouse 
button. A menu will pop up to choose a new value. To change the 
attribute value of several preferences, select the preferences to 
change (see above) and point to the value of one of the selected 
lines. All the selected preferences will change to the selected 
value. 

 For information on the attributes and their possible values, refer 
to the section “Processing Options” later in this chapter. 

 



 Image Queue Windows                141 

Image Queue Windows 
 

Image queue windows enable you to group images into a queue, 
enhance images in the queue, and monitor the status of MacRascol 
Print Monitor processing. To view an image queue, select New Image 
Queue…, Open Image Queue…, or Open Print Queue from the File 
menu. 
 
 
 
The image window lists images in a queue, the processing options 
assigned to each one, and the printing status of each. 
 
Scrolling 

 If there are more images than fit in the window, you can change 
the window height or use the right-hand scroll bar to scroll 
through the list. If more attribute columns are active in the window 
than will fit, you can change the window width or use the lower 
scroll bar to scroll across the matrix. 

 
Images 

 The first column lists the names of the images. To select an 
image, click on the name. To select more than one, hold down 
the command key and click or drag. To select a contiguous 
range, use the shift key. To change the order of images in the list, 
drag the selected image name(s) up or down the list to a new 
location. To duplicate an image, hold down the option key and 
drag the copy up or down the list to a new location. 

 Clicking on the title of the first column (Images) will alternately 
deselect and select all items in the list. 

 
Information Box 

 The information box is in the lower left corner of the window. 
Clicking on the box changes the information displayed. You can 
display Copies Waiting, Copies Done, or Time Done. 

 
Edit Menu 

 The Edit menu may be used to operate on the list. You can cut, 
copy, clear, or duplicate the selected items. You can paste PICTs 
or image queue items from the clipboard. Use Select All to select 
all items in the list. 

 
Images Menu 

 The Images menu is described above in the section “Menus and 
Commands.” 
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Process 
Add Image… 
Add Many… 
Paste 
Delete Image 
Crop Image 

 The buttons perform the same functions as the commands in the 
menus. They are repeated here for convenience. 

 
Dragging images from the Finder 

 Selecting image documents in the Finder and dragging them over 
an image queue window causes the window to highlight. If the 
image documents are dropped on the window, those images are 
added to the image queue. 

 
Attributes 

 The rest of the columns list the attribute values (processing 
options) for each image. Use the Attributes menu to control which 
attribute columns are included in the window. To select a column, 
click on the title at the top. To select more than one, hold down 
the shift key and click or drag across the title row. To change the 
order of the attributes, drag the selected title(s) left or right to a 
new location. 

 To alter the width of the Images column or an attribute column, 
point to the right-hand edge of the column in the title (top) row. 
Drag the column edge to the left to shrink, or right to widen the 
column width. 

 
Values 

 To change an attribute value, point to it and push the mouse 
button. A menu pops up to choose a new value. To change the 
attribute value of several images, select the images to change 
(see above) and point to the value of one of the selected lines. All 
the selected items will change to the selected value. 

 For information on the attributes and their possible values, refer 
to the next section: “Processing Options”. 
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Processing Options 
 

This section describes the processing options or attribute values in 
the Preference list and the Image Queues. 
 
 

 

Image Type 
The Image Type value lists the format of the image file.  
 
 
 
 

 

Status 
The status value specifies how the image is to be processed, or 
shows the results of processing.  
 
A pop up menu on each item in the column sets the status for the 
selected image only. 
 
 When the queue is processed those items with a Waiting status 

will be imaged; MacRascol Print Monitor will skip all others. When 
an image is added to an image queue, the status is set to 
Waiting. 

 You can set the status to Hold in order to bypass the imaging of 
an item. The MacRascol Print Monitor will also set the status to 
Hold if you skip the image. 

 The MacRascol Print Monitor sets the status to Printing for the 
length of time it is imaging the item. You are prevented from 
modifying the attributes of the item while it is printing. 

 When MacRascol Print Monitor has completed processing all the 
copies of the item, the status is set to Done. The time it took to 
process the item is listed (in minutes and seconds). 

 If an error prevented the image from being processed, the status 
is set to Error. An error code is listed also. Point to Error, pop up 
the menu, and select Error. A window appears showing an 
explanation of the error code. 

 
 

 

Preferences 
The preferences value shows the name of the preference that has 
been applied to the image queue item. A preference contains all the 
processing options that the MacRascol Print Monitor uses for 
imaging. These options are the values of the remaining attributes in 
this section; i.e., all except File Type and Status. 
 
If this field is blank, one or more of the values has been changed 
since the preference value was assigned to the item. This field is also 
blank for images printed to an image queue from a MacRascol driver. 
 
The menu that pops up when the value is pressed lists all the items in 
the Preferences window. When a menu item is selected, all the 
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processing options for that preference item are copied to the image 
queue item. 
 
If the processing options in the Preferences list are subsequently 
altered, the processing options of the image queue item are not 
changed. 
 
 

 

Copies 
The Copies value shows the number of copies you want to output. 
 
Note: If the MacRascol software is configured for BLL file output (the 

BLL File driver is chosen), then the Copies field should be set to 
one. 

The menu that pops up when the value is pressed lists all the values 
for Copies in this window. Select one of these values, or Other… to 
type a different value. 
 

 
 
 

 

Film Recorder 
Set this to the film recorder model that is connected now or when the 
BLL file will be imaged. 
 
Note: Select the correct type so that other attributes can be selected 

properly. 

If the image type is BLL, then this field is shown in gray. The film 
recorder model is encoded inside BLL files. 
 
 

 

Film Type 
Set this to the type of film loaded in the camera back. 
 
If the image type is BLL, then this field is shown in gray. The film type 
is encoded inside BLL files. 
 
If this field is shown with a heavy (red) box around it, the film type is 
not available for the film recorder chosen. Be sure to select a different 
film type before processing the queue. 
 
Film types listed in the second section of the Film Type menu come 
from Lasergraphics Film Calibration (LFC) files stored in the 
MacRascolQ Data folder inside your system folder. 
 
 

 

Resolution 
Set this to the pixel resolution desired. 
 



 Processing Options                145 

If the image type is BLL, this field is shown in gray. The pixel 
resolution is encoded inside BLL files. 
 
If this field is shown with a heavy (red) box around it, the pixel 
resolution is not available for the film recorder chosen. Be sure to 
select a different resolution before processing the queue. 
 
 Fast (2K) resolution produces 2000-line images. 

 Fine (4K) resolution produces 4000-line images. 

 Extra Fine (8K) resolution produces 8000-line images. 

 Ultra Fine (16K) resolution produces 16000-line images. 

The “Working With Specific Images” section of the Using MacRascol 
chapter describes which setting to use for specific images. 
 
 

 

AntiAliasing 
Set this to the antialiasing level desired. 
 
If the image type is BLL, this field is shown in gray. The antialiasing 
value is encoded inside BLL files. 
 
 Antialiasing is seldom useful for film recorders, especially when 

exposing at Fine, Extra Fine, or Ultra Fine resolution. However, 
Level 1 antialiasing may produce smoother edges and lettering in 
images.  Level 2 antialiasing is a more intense version of Level 
1.  Note that antialiasing increases processing time significantly.   

 
 

 

Minimum Exposure Time 
This option allows you to match the timing of your film recorder to the 
MacRascol rasterizer. Doing this eliminates periodic faint horizontal 
lines that sometimes appear when the film recorder is forced to wait 
for data from the rasterizer. If you prefer, you may eliminate this 
problem by adding more memory to your film recorder. 
 
Recent Lasergraphics film recorders will automatically adapt to 
virtually any data rate. It is highly likely you will never have to use this 
option. 
 
If the image type is BLL, then this field is shown in gray. The 
minimum exposure time is encoded inside BLL files. 
 
The menu that pops up when the value is pressed lists all of the 
values for Minimum Exposure Time in this window. Select one of 
these values, or Other… to enter a different value. 
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 Click Fastest Possible if there are no periodic faint horizontal 

lines, and you are satisfied with the output slides.  Click Minutes 
if periodic faint horizontal lines exist.  Then type the minimum 
exposure time in minutes (e.g. 5.5) in the box.  This will be the 
fastest possible exposure time for this image.  Sometimes an 
image will take longer.  As an initial value, multiply the normal 
imaging time by 1 1/2 and use that as the minimum exposure 
time.  If the lines still exist, try a factor of 2, and so on until they 
disappear. 

 
 

 

Color Balance & Gamma 
This option allows you to adjust the balance of the three film recorder 
colors: Red, Green, and Blue, and also lets you change the 
Contrast Gamma value. 
 
If the image type is BLL, this field is shown in gray. Color balance and 
gamma are encoded inside BLL files. 
 
The menu that pops up when the value is pressed lists all the values 
for Color Balance & Gamma in this window. Select one of these 
values, or Other… to enter a different value. 
 

 
 
Normally, each color and Brightness is set at 100%.  Since color 
perception is subjective, this dialog box lets you adjust the film 
recorder’s color balance to match your taste.   
 
Increasing the amount of a given color causes that color to be more 
prominent than the other two.  For example, if you increase Blue, 
your images will have a bluish cast.   
 
Decreasing the amount of a color causes the other two colors to be 
more prominent.  For example, if you decrease the amount of Blue, 
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your images will look more yellow.  This is because decreasing Blue 
is like increasing Red and Green, which combine to form yellow. 
 
 Doubling a color’s value results in twice as much of that color in 

your images.  However, since Color Balance is intended for 
making slight changes in overall color and not for improving poor 
images, you should normally restrict all changes to the range 80–
120%. 

 
You may adjust all three colors together by changing the Brightness  
value.  This has the effect of changing the overall brightness of the 
image without changing the color balance.  The range of the 
Brightness setting is restricted depending on the settings of Red, 
Green, and Blue. 
 
The Contrast Gamma adjustment allows you to adjust the contrast of 
the output image through a nonlinear function. 
You may set the value of Gamma in the range of 1/7 to 7 (0.14 to 
7.00); although, useful values are usually between 0.25 and 2.00.  By 
adjusting Gamma you can affect the midtones of the image without 
affecting the highlights.  When Gamma is between 1/7 and 1, output 
midtones are darker.   When Gamma is between 1 and 7, output 
midtones are lighter.  Lower values of Gamma produce higher 
contrast output images, and higher values of Gamma produce lower 
contrast output images.   
 
 When Gamma is 1, the gray mapping is linear, and output 

images have a “flat” contrast.  However, most images look best at 
a Gamma of 0.5 to 0.7. 

 
The graph displayed in the window shows how input intensity values 
are mapped to output intensities.  The horizontal axis increases from 
left to right and represents pixel brightness IN. The vertical axis 
increases from bottom to top and represents adjusted pixel 
brightness OUT. 
 
Note that many other factors affect the final color you see on the film: 
the film manufacturer, the type and age of the film, and the 
equipment, chemicals, and experience of the film developer. 
 
 

 

Patterns 
This option allows you to adjust the size of patterned objects in your 
image. 
 
This option only applies to PICT and Print images. For all other image 
types this field is shown in gray. 
 
The menu that pops up when the value is pressed lists all the values 
for Patterns in this window. Select one of these values, or Other… to 
enter a different value. 
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 Click Blend Patterns to paint all patterned objects with a color 

that is the average of the colors of the pixels in the pattern. Use 
this if the patterns are being used as halftones to create 
intermediate colors. 

 Click a percentage to scale the pattern for the film. Use this if the 
patterns are being used to create textures. Since the pixel 
resolution being exposed on film is much greater than the 72 dpi 
of the screen, the pixels in the pattern need to be scaled up to 
see the texture. At 100%, the pixels are scaled so that they 
appear approximately the same size as on the screen (72 dpi x 
12 inches across the film). Note that since the pixels are being 
scaled up, they may appear “blocky” on the film. 

 
 

 

Black & White 
When set to Invert, black areas in the image are output as white and 
white areas are output as black. Gray areas are unaffected. You 
should only use this option on black and white images. Most images 
should use the Normal setting. Invert may produce unexpected 
results on color images. 
 
This option only applies to PICT and Print images. For all other image 
types this field is shown in gray. 
 
The inversion applies to output only.  You won’t see any change in 
the cropping window.  This option does not change the 
Background color used with the image. 
 
 Slides that are mostly white space with a few thin black lines 

don’t look good.  Therefore, use Invert when making slides of line 
art. 

 
 

 

Character Spacing 
Use Fine Spacing if your application uses fractional widths.  
 
This option only applies to PICT and Print images. For all other image 
types this field is shown in gray. 
 
Every font character has a spacing value associated with it.  This 
value specifies the distance to the adjoining character in increments 
of 1

72    of an inch.  Certain fonts also have fractional width values that 
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are more accurate than the standard 1
72    of an inch.  Application 

programs may or may not take advantage of fractional widths.   
 
Incorrectly setting this option causes lines of text to be output 
differently from the way they appeared in the graphics application 
program.  For example, a text label inside a box may flow out through 
the right side of the box. 
 
 Changing this option with the cropping window displayed affects 

text that uses fractional widths. This way you can easily tell 
whether to use Fine Spacing or Granular (Off). 

 
 

 

Background 
Defines the color of the background painted behind the image. 
 
If the image type is LL or BLL, then this field is shown in gray. 
Background color information is encoded inside LL and BLL files. 
 
The menu that pops up when the value is pressed lists all the values 
for Background in this window. Select one of these values, or Other… 
to pick a different color. 
 
 The cropping window displays the background color with the 

selected image. This way you can easily see how your image 
looks with the selected background color. 

 
 

 

Orientation 
You can specify an output orientation of Portrait (vertical), 
Landscape (horizontal), or Automatic. 
 
With Automatic selected, if the image height is greater than the width 
then Portrait orientation will be used. If the width is greater than the 
height then Landscape orientation will be used. 
 
This option only applies to PICT and Print images. For all other image 
types this field is shown in gray. 
 
 

 

Cropping 
Cropping lets you trim off parts of the image that you don’t want. You 
can also crop the image using the cropping window. 
 
This option only applies to PICT and Print images. For all other image 
types this field is shown in gray. 
 
The menu that pops up when the value is pressed lists all the values 
for Cropping in this window. Select one of these values, or Other… to 
enter a different value. 
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 Check Default Cropping to fit all the image onto the film. When 

Default Cropping is checked, the values shown are the edges of 
the image drawn by the application that created it. 

 Uncheck Default Cropping and type in values for Top, Left, 
Bottom, and Right to trim the image. Note that the value for Top 
must be less than the value for Bottom, and Left less than 
Right. Changes made to the Cropping values will change what 
is shown in the cropping window. 

 
 

 

Pen Thickness 
This option adjusts the thickness of lines drawn. 
 
This option only applies to LL and HPGL images. For all other image 
types this field is shown in gray. 
 
 The Default setting should be satisfactory most of the time. You 

can specify the exact number of pixels to use if your image does 
not appear as intended. 

 
 

 

Plotter Model 
This option defines the model of the plotter to emulate. 
 
This option only applies to HPGL images. For all other image types 
this field is shown in gray. 
 
 Use the setting matching the model for which the application 

creating the image file was configured. If you are not sure, try HP 
7475A. 

 
 

 

Pen Colors 
This option lets you set the colors of the 8 plotter pens. 
 
This option only applies to HPGL images. For all other image types 
this field is shown in gray. 
 
Clicking on the Pen Colors value will show a window that lists the 
colors for each pen: 
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Pop up a menu for each pen to change the color. Select Custom 
Color… from the menu to access the system color picker. 
 
 

 

Raster Scale 
This option lets you set the raster scaling parameters, which change 
the size and shape of a Targa, TIFF, or Photoshop image on film. 
 
This option only applies to raster file images: Photoshop, Targa, and 
TIFF. For all other image types this field is shown in gray. 
 
The menu that pops up when the value is pressed lists all the values 
for Raster Scale in this window. Select one of these values, or 
Other… to enter a different value. 
 

 
 
 Pixel Height:Pixel Width changes the pixel aspect ratio for the 

image. A value of 1.0 specifies normal, square pixels. Any other 
value will stretch or distort the image. 

 In changing the aspect ratio of the pixels, note that the aspect 
ratio of the entire image is affected. For example to stretch the 
width of an image sized for a computer screen (3:4 aspect ratio) 
to fill a slide (2:3 aspect ratio), use a value of (2/3)/(3/4) = 0.889. 



152           MacRascol Queue Builder Reference 

 Click Best fit of entire image in frame to fit the entire image in 
the slide frame. The image will be scaled so that all the pixels of 
the file are shown in the output. If the image is taller than the film 
frame, borders will appear on the sides. If the image is wider than 
the film frame, borders will appear on the top and bottom. These 
borders will be colored with the Background color. 

 This scaling to fit the frame is done after the Pixel Height:Pixel 
Width value modifies the aspect ratio of the image. 

 Click Crop edges of image to fill frame to fill the slide frame 
with the image. The image will be scaled so that there are no 
borders in the output. If the image is taller than the film frame, 
some of the top and bottom will be cropped off. If the image is 
wider than the film frame, some of the sides will be cropped off. 

 This scaling to fill the frame is done after the Pixel Height:Pixel 
Width value modifies the aspect ratio of the image. 

 Click Match pixels of image and frame to map the pixels of the 
image one-to-one with the pixels on the film. The image will not 
be scaled at all. If there are more pixels in the image than the 
selected film resolution, the edges of the image will be cropped 
off. If there are fewer pixels in the image than the selected 
resolution, borders will appear around the picture.  

 This scaling to fill the frame is done after the Pixel Height:Pixel 
Width value modifies the aspect ratio of the image. If the value is 
not 1.0, the vertical pixels are matched, and the horizontal pixels 
are scaled to the proper aspect ratio. 

 Use Additional Scaling to scale the image to some other size in 
the film frame. 100% is the normal value. The center of the image 
will always be placed in the center of the film frame. 

 This additional scaling is done after the Pixel Height:Pixel Width 
value and the Best fit/Crop edges/Match pixels selection modifies 
the image size. 
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The Cropping Window 
 

The Cropping window lets you preview and trim the image selected in 
an Image Queue window.  Note that this feature is only available if 
the selected image is a PICT or Print file type. 
 

 
 
The Selection Rectangle 

 The selection rectangle defines the cropped area.  The image is 
cropped to the inside edge of the rectangle.   

 You can resize the rectangle by dragging any edge or corner.  
Holding the shift key constrains the rectangle to the correct 
aspect ratio of the selected film type (slide film is 2:3) for a given 
orientation. 

 You can move the selection rectangle around the image by 
pointing inside the rectangle and dragging it.  

 Enlarging the rectangle will shrink the image on the film. 
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Magnifying Tool 

 Click to display a rectangle with a crosshairs center point that 
defines the area to be shown in the magnified image.  Click the 
center of the area you want to enlarge.  Note that this operation is 
for viewing purposes only and does not affect the cropping of the 
image. 

 
Reduce 

 Click to reduce the image.  Note that this operation is for viewing 
purposes only and does not affect the cropping of the image. 

 
Default Cropping 

 Crops the image as specified in the image’s PICT file. 

 
Update 

 When the update box is checked, the Cropping window will 
redraw the selected image when necessary.  If the update box is 
unchecked, the areas that need to be redrawn will be filled with 
gray.  You may wish to use this if you have selected a complex or 
large image that takes a long time to redraw. 

 While the cropping window is drawing on the screen, the cursor 
changes to a watch. On Power Macs, clicking the mouse button 
while the window is drawing will cancel the drawing. 
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MacRascol Print 
Monitor Reference 

 

 
This chapter describes MacRascol Print Monitor windows, menus, 
and commands. 
 
The first section, “The MacRascol Print Monitor Window,” 
describes the components of the main window. 
 
“Menus and Commands” describes the MacRascol Print Monitor 
menus and commands. 
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The MacRascol Print Monitor Window 
 

The MacRascol Print Monitor window lets you start or stop 
processing and shows the status of the queue being processed.   
 

 
 

 

Status Messages The top line is the status line.  The following table lists potential 
status messages. 
 

Message Description 

Imaging stopped No processing is in progress. 

Exposing:  film type. An image is being processed for a 
film recorder. 

Waiting for Print 
Images. 

The Print Monitor is waiting to 
process images from the Print 
Queue as soon as they are queued. 

Aborting current 
exposure. You clicked Abort. 

Imaging will stop when 
current exposure has 
completed. 

You clicked Stop. 

Imaging stopped.  
Unable to communicate 
with Film Recorder. 

The film recorder is not connected or 
the SCSI ID is incorrectly set. 
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Image 

 The name of the image that is waiting to be processed or is being 
currently processed.  This is blank when all images in the queue 
have been processed. 

Copy 

 Indicates which copy of multiple copies of the current image is 
being processed.  This is displayed only while processing is in 
progress. 

Images Done 

 Indicates the number of images in the current queue that have 
been processed successfully. 

Images Left 

 Indicates the number of images in the current queue that are 
remaining to be processed. 

Image Queue 

 Indicates the name of the queue being processed. 
 
 

 

Buttons Stop 

 Click to halt processing after the current image is done.  This 
button is available only while processing is in progress.  
Compare with Abort. 

 
Start 

 Click to begin processing images in the current queue. 

 !NOTE:  The output device should be turned on and ready 
before you click Start.   

Skip Image 

 Click to bypass the current image and proceed to the next 
queued image.  Image status is set to Hold automatically.  The 
button changes to Abort during processing. 

Abort 

 Click to halt processing immediately.  The current exposure or 
page may be ruined.  This button changes to Skip Image when 
processing stops.  Compare with Stop. 



158           MacRascol Print Monitor Reference 

Menus and Commands 
 

This section describes the MacRascol Print Monitor menus and 
commands. 
 

 

The File Menu 

 

File menu commands enable you 
to open a queue for processing, 
start processing from the Print 
Queue, and quit MacRascol Print 
Monitor. 

 
 

Process Image Queue... Displays a dialog box that lets you open an image queue. 
 
 
 

Process Print Queue  Starts processing images from a special queue called the Print 
Queue, which you can manipulate like other queues, but which 
MacRascol Print Monitor treats specially. When MacRascol Print 
Monitor runs in the background, it will immediately process any 
image that appears in the Print Queue, and each image will be 
deleted from the queue upon successful completion.  See the 
subsection titled “To Begin Processing the Print Queue” in the 
section “Processing Queues for Output” in the Using MacRascol 
chapter for a detailed description of Print Queue operation. 
 
 

Open "Image Queue 
Name" 

Opens a window in MacRascol Queue Builder that shows the 
contents of the image queue currently selected for processing. 
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Unused Memory... Displays a dialog box that lets you specify how much RAM memory 
MacRascol Print Monitor leaves for use by system functions. 
 

 
 
In most cases, leave the unused memory set at the default (200K in 
this case).  However, you will need to set it higher if you get an error 
while imaging that tells you to increase Unused Memory. 
 
 

Skip All In the Print Queue, selecting Skip All will delete all images waiting. 
In other queues, Skip All causes all images waiting to change status 
to hold. 
 
 

Quit  Halts any processing, exits MacRascol Print Monitor, and returns 
you to the Finder. 
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MacRascol Server 
Reference 

 

 
This chapter describes MacRascol Server windows, menus, and 
commands. 
 
The first section, “The MacRascol Server Window,” describes the 
components of the main window. 
 
“Menus and Commands” describes the MacRascol Server menus 
and commands. 
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The MacRascol Server Window 
 

The MacRascol Server window lets you start or stop communication 
and shows the status of the communication with the client.   
 

 
 
 

 

Status Messages 
Server 

 Indicates the name the server is using to identify itself over the 
AppleTalk network. 

Client 

 The name of the client computer being served is shown. 

Status 

 The mode of processing is displayed. 

Message Description 

Inactive No processing is in progress. 

Initializing Server Preparing for network 
communications. 

Waiting for SCSI device Checking local film recorder. 

Waiting for Request Ready for communications from 
clients. 

Serving Client Actively communicating with client. 

Will stop after current 
client You clicked Stop. 

Aborting Server You clicked Abort. 
 



 The MacRascol Server Window                163 

 
 

Buttons Stop 

 Click to halt processing after the current client is done sending 
images. This button is available only while actively serving a 
client. Compare with Abort. 

 
Start 

 Click to begin communications. 

 !NOTE:  The film recorder should be turned on before you click 
Start.   

Abort 

 Click to halt communications immediately.  The current exposure 
or page may be ruined. Compare with Stop. 
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Menus and Commands 
 

This section describes the MacRascol Print Monitor menus and 
commands. 
 
 

 

The File Menu  File menu commands enable you 
to set the server name and quit 
MacRascol Server. 

 
 

Server... Displays a window that lets you set server options. 
 

 
 
Server Name: 

 The name seen in the Chooser window of client computers 
when the LFR Server driver is chosen. The default name is 
“Lasergraphics.” 

 
Automatic Reserve 

 Check this option to make all clients reserve the server for the 
duration of their image communications. When this option is 
unchecked, individual clients may still reserve the server in the 
LFR Server driver‘s Manual Setup window. 

Header Page 

 This option is available if Automatic Reserve is checked. A 
header page will be printed whenever a new client’s images are 
started. 

 
 

Quit  Aborts any communications and exits MacRascol Server. 
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Appendices 
 

The first appendix, “Appendix A – Specifications,” lists MacRascol 
specifications. 
 
“Appendix B – Using LL Images” describes how to bring LL images 
into the Macintosh environment. 
 
“Appendix C – Speeding Up Processing” provides some helpful 
tips on making the rasterization process run more quickly. 
 
“Appendix D – Troubleshooting” describes service procedures and 
explains how to solve some common problems. 
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Appendix A – Specifications 
 

Specifications are subject to change without notice. 
 

Supported Macintosh Macintosh with a 68020, 68030, 68040, or PowerPC processor 
 

Supported Output Devices These Lasergraphics film recorders: 
Personal LFR Personal LFR Plus 
LFR-X LFR-X95 
LFR Mark II LFR Mark II Digital Photography Model 
LFR Mark III LFR Mark III Digital Photography Model 
LFR Mark V Digital Photography Model 
LFR Mark VI Digital Photography Model 
Personal LFR Pro  

 
Supported System Versions Macintosh System 7.0, up to Mac OS 9 

 
Supported Networks AppleTalk protocol used with any local area network. 
Input File Formats PICT I or PICT II files PICT on the Clipboard 
 PICT in a Scrapbook PICT Clipping files 
 HPGL Lasergraphics Language (LL) 
 Targa files TIFF 
 Photoshop 2.0 files Photoshop 2.5 files 
 Dicomed Tile files BLL 
 Chooser Driver (Print command in applications) 

 
Image Enhancements Cropping (with zoom) Invert black and white 
 Color balance correction Pattern scaling 
 Gamma correction Antialiasing 

 
Fonts Macintosh screen fonts 
 Any TrueType font 
 With ATM: Any Type 1 PostScript font 

 
Software Selectable Resolution 
(Film Recorder) 

16000 lines (16384 x 10922 pixels) 
8000 lines (8192 x 5461 pixels) 
4000 lines (4096 x 2731 pixels) 
2000 lines (2048 x 1365 pixels) 
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Supported Camera Backs/Film 

Formats  
Lasergraphics SmartBack™ - 35mm 
Lasergraphics SmartLoader™ - Automated high-volume 35mm 
339 - Instant Print 
669/661 - Instant print/transparency 
4˝x 5˝ 
120/220 - 6cm x 7cm 
Bulk Load 
 

Supported Film Types  Fuji Digital Output Film slides 
Fuji NPS 160 negative film 
Fuji NS 160 negative film 
Fuji Provia 100 slides and transparencies 
Fuji Reala 100 negative film 
Fuji Sensia II 100 slides 
Fuji SuperG 100 negative film 
Fuji SuperG Plus 100 negative film 
Kodak E100S slides 
Kodak Electronic Output Film slides 
Kodak EPP 100 slides and transparencies 
Kodak Gold 100 negative film 
Kodak Portra NC 160 negative film 
Kodak Rapid Process Copy slides 
Kodak Tmax 100 Professional black and white film 
Kodak Vericolor III negative film 
Konica 160PS  
Konica Sinra 100 slides 
Polaroid 339 Print instant prints 
Polaroid 669 Print instant prints 
Polaroid 691 instant transparencies 
Polaroid Polachrome instant slides 
 
Contact Lasergraphics, Inc. for information on unlisted film types. 
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Appendix B – Using LL Images 
 

Lasergraphics Language (LL) images are typically created on 
minicomputers or mainframes.  Since LL images are standard ASCII 
files, they can be transferred to the Macintosh and processed for 
output by MacRascol.   
 
You can transfer files to a Macintosh via network, 
telecommunications, or PC floppy disk.  If possible, the LL file should 
be saved on your Macintosh with the file type TEXT. 
 
MacRascol Quick Print and MacRascol Queue Builder only recognize 
LL files with the file type TEXT. 
 
If MacRascol doesn’t recognize the LL file when you select Print 
Files or click Add One, the file type is probably incorrectly set.  Ask 
your dealer for information on a utility that lets you set the file type. 
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Appendix C – Speeding Up Processing 
 

These are some ways you can increase the speed of MacRascol 
Print Monitor processing.  
 

 Adjust the available memory 

 You can open MacRascol Print Monitor with as little as 2048K of 
available memory.  However, performance may suffer.  

 Performance improves when you allocate up to 7168K to 
MacRascol Print Monitor. Do not allocate much more than 7168K. 
See the section titled “Processing Queues for Output” in the 
Using MacRascol chapter. 

 
 Use a disk cache 

 You can set up a disk cache using the Memory Control Panel. 

 
 Don’t run other applications with MacRascol Print Monitor 

 Running other applications takes processing time away from 
MacRascol Print Monitor. Sometimes removing or turning off the 
Apple's Desktop Print Monitor is helpful. 

 
 Put your images on a local hard disk, not a network disk or a 

floppy  

 This is especially helpful for images that contain bitmaps. 

 
 Use Photoshop format files 

 Photoshop files are the easiest and fastest of the raster formats 
for the film recorder to image. 

 
 Use a lower resolution 

 2K (Fast) resolution processes faster than 4K (Fine), 8K (Extra 
Fine), or 16K (Ultra Fine) resolution. This is especially important 
for low-resolution bitmapped images because there is no benefit 
from using a higher resolution. 

 
 Don’t use antialiasing 
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Appendix D – Troubleshooting  
 

This appendix describes some common problems and possible 
solutions. 
 
If you can’t find a solution in this appendix, search the Lasergraphics 
web site at: 
 

http://www.lasergraphics.com 
 
You are also welcome to contact the Lasergraphics Technical 
Support Department: 
 

e-mail : techsupport@lasergraphics.com 
(Please, no files larger than 100k via e-mail, no HTML, no long 
lines) 

 
949-753-8292 
Monday through Friday 
7:30 A.M. to 5:30 P.M., Pacific Time Zone 

 
When a problem occurs, try this simple reset procedure: 
 
1. Quit all MacRascol applications. 

2. Shut down your Macintosh. 

3. Turn your output device off. 

4. Wait 30 seconds. 

5. Turn on your output device and then your Macintosh. 

6. Retry the operation that caused problems. 

 
If the problem continues, try turning off extensions by holding down 
the shift key while restarting the Macintosh. Retry the operation. 
 
If the problem persists, refer to the following sections looking for the 
problem you have and follow the suggested solutions. Also, check the 
user guide that came with your film recorder for other troubleshooting 
procedures. 
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MacRascol Chooser Driver Problems 

This section describes problems that can occur while you are using a 
MacRascol Chooser driver through the Print command of your 
application. 
 
 

Image is blank in Cropping 
window 

Verify that the Update box is checked. 
 
The image may be too big or complex to preview in the Cropping 
window.  However, it will be properly imaged when processed with 
MacRascol Print Monitor. 
 
 

Magnify or Reduce feature 
in Cropping window results 
in blank image or has no 
effect 

The Cropping window cannot magnify or reduce the preview of the 
image any further.  Note that this does not affect how MacRascol 
Print Monitor processes images.  MacRascol Print Monitor will 
correctly output the image. 

 
 

Can’t open printer or 
Unable to access printer 

Close the Chooser. 

 
 

MacRascol Chooser driver 
produces miniature images 

Uncheck Native Resolution in the Page Setup window if possible, 
or increase the scale factor in the Page Setup window to enlarge 
the image. 
 
 

MacRascol Chooser driver 
outputs images with 
jagged edges 

Check Native Resolution in the Page Setup window if possible.  
This may improve the quality of your output.  If this fails to make an 
improvement, your source image may be of limited resolution. 
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MacRascol Queue Builder Problems 

This section describes problems that can occur while you are using 
the MacRascol Queue Builder application. 
 
 

Colors in the Cropping 
window don’t match the 
original 

This is not an error. 
 
The Cropping window shows an approximation of the finished 
image. Many Macintosh video drivers support only 8-bit-color (256 
colors).  With 8-bit video drivers the displayed colors will be the 
closest matching color in the 256-color palette.  The colors you see 
on the screen may differ significantly from the actual colors 
specified in the image.  However, the specified colors will appear in 
the processed image. 
 
 

The image won’t paste into 
the queue 

Either there is no image on the Clipboard or the image is not a PICT 
image. 
 
You can only paste PICT images into the queue. 
 
 

This dialog box appears 
when you are using 
MacRascol Queue Builder 

 
 
This dialog box indicates that the queue you wanted to work with is 
corrupted, missing, or in use.  You have the option to Quit 
MacRascol Queue Builder, Continue with the current image queue, 
create a New Image Queue, or Open an existing Image Queue. 
 



 Appendix D – Troubleshooting                173 

MacRascol Print Monitor Error Messages 

This section describes some of the error messages that can occur 
with the MacRascol Print Monitor background application.  Error 
messages appear after the “imaging stopped” message. 
 
 

Camera is out of film The camera back ran out of film while exposing the images in the 
queue.  Unload the film and add a new roll of the same type.  Follow 
the instructions provided in your film recorder manual for loading 
and unloading film. Imaging will resume within two minutes. 
 
 

Device not ready This is a generic error message indicating something is wrong with 
the film recorder connected to the Macintosh.  Check that all cables, 
including the camera back cable and SCSI cables, are securely 
connected. 
 
 

Missing or wrong camera 
back 

This error occurs either when the camera back is not connected to 
the film recorder, or the camera type does not match the film type 
you specified in the MacRascol Chooser driver or MacRascol 
Queue Builder. 
 
Make sure the camera back is mounted properly and that the camera 
cable is plugged into the film recorder. Then, choose the correct Film 
Recorder and Film Type in the image queue with MacRascol Queue 
Builder. For example, if you selected slide film, make sure you are 
using a 35mm camera. 
 
 

Not enough memory... There is not enough application memory available for MacRascol 
Print Monitor to process images. 
 
Increase the application memory requirements.  Adjusting the 
application memory requirements is described in the “Processing 
Queues for Output” section of the Using MacRascol chapter. 

 
!NOTE:  To maximize your available memory for applications, you 
should reduce the system RAM Cache or turn on virtual memory. 
 
 

...Increase Unused 
Memory 

There is not enough Unused Memory available for MacRascol Print 
Monitor to process images. 

 
Increase Unused Memory in the File menu. Setting Unused 
Memory is described in the “Processing Queues for Output” section 
of the Using MacRascol chapter. 
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Unable to communicate 
with Film Recorder 

The SCSI interface is not connected or the SCSI ID number 
specified in the SCSI LFR Chooser driver does not match the LFR’s 
SCSI ID number. 
 
Make sure that all SCSI connections are intact, and that the SCSI 
chain is properly terminated.  Make sure the SCSI ID number 
specified using SCSI LFR matches the DIP switch setting on the 
LFR’s rear panel.  See the Installation chapter of your LFR’s manual 
for instructions on setting the LFR’s DIP switch. 
 
 

Unable to open Image file MacRascol Print Monitor may not be able to open a PICT file 
because the file is corrupted or because the file was deleted after 
being added to the queue. 
 
Check whether the PICT file still exists.  You can use the Open 
Enclosing Folder… function in Queue Builder. 
 
If the PICT file still exists, use your graphics application to check if it 
is corrupted.  If the image is corrupted, you probably won’t be able to 
open it.  If you can open the image, save the image under a different 
name and then add it to the queue again. 

 
 

Unable to find program to 
send to RISC Rascol 

MacRascol Print Monitor cannot find the RISC Program file in the 
MacRascolQ Data folder within your System Folder. Reinstall the 
MacRascol software. Alternatively, uncheck the Use RISC Rascol 
or Internal Rascol option in the MacRascol Chooser driver under 
Manual Setup. 
 

 
Unable to send program to 
RISC Rascol 

MacRascol Print Monitor is having trouble communicating with the 
RISC Rascol, or the RISC Program file in the MacRascolQ Data 
folder is unreadable or corrupted. 
 
Make sure the RISC Rascol is connected securely to your 
Macintosh or another SCSI device, and the SCSI chain is properly 
terminated. 
 
If the error persists, reinstall the MacRascol. 
 

 
Version of RISC Rascol 
program is not compatible 

You have an obsolete version of the RISC Program installed on 
your disk. Reinstall the MacRascol software. Be sure to use the 
MacRascol Print Monitor program from the same release disk. 
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MacRascol Print Monitor Problems 

This section describes some of the problems that can occur while 
using the MacRascol Print Monitor application. 
 
 

“Images Left” shows zero 
images 

This can result from three situations.  All images in the queue may 
have been output, the status for some images is set incorrectly, or 
MacRascol Print Monitor is working with the wrong queue. 
 
When all images in the queue have been output, Images Left shows 
zero images.  This indicates that all images in the queue have been 
output. 
 
If an image’s status (in MacRascol Queue Builder) is not set to 
Waiting, that image will not be included in the Images Left total.  If 
no images in the queue are waiting, Images Left shows zero. 
 
MacRascol Print Monitor may be working with the wrong queue.  
Check the bottom line of the MacRascol Print Monitor window and 
make sure you are processing the correct queue.  If the queue name 
is correct, make sure you aren’t working with a different queue by the 
same name. Quit MacRascol Print Monitor. Select the queue you 
want to process in MacRascol Queue Builder. Select Start 
Processing from the File menu. 
 

Processing is very slow This is usually due to one of the following: 
 
! MacRascol Print Monitor does not have enough memory for 

efficient processing.  Increase the application memory size.  
See “Not enough memory...” above for details. 

 
! MacRascol Print Monitor has too much memory for efficient 

processing.  Decrease the application memory size under 
7168K. 

 
! You have virtual memory on and have set the application 

memory size to be greater than 75% of your real memory.  
Reduce the application memory size to be under 75% of your 
real memory or turn virtual memory off. 

 
! If you are using the Internal Rascol on an LFR-X or Mark series 

LFR and you have a Quadra or Power Macintosh, uncheck the 
use RISC Rascol or Internal Rascol option in the MacRascol 
Chooser driver Manual Setup window. 

 
See also Appendix C - Speeding Up Processing. 
 
 

Problems with Output This section describes some common problems with image output.  
Also check the user guide of your output device for device specific 
problems. 
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The image is blank If this happens with a PICT image, your cropping may be set 
incorrectly. Check the Cropping window and make sure your image 
is within the cropping frame. 
 
If this happens with an LL image, then the image file may not 
contain valid LL syntax.  Remember that LL image files are files of 
type TEXT, which is a generic file type containing standard ASCII 
text.  Make sure that the image file you have chosen contains valid 
LL syntax. 
 
HPGL files are also text files. All text files show up in the add dialog. 
You can add any text file, but since they aren’t files MacRascol can 
interpret, they will come out black. Some typical text files are 
PostScript files and files brought to the Mac from a PC. Be sure you 
are adding files we understand.   
 
If you image a text file with black text and a clear background, you 
will get a black image when the background color is set to black. 
 
 

The wrong images were 
output 

There can be two causes for this:  you added the wrong images to 
the queue or you processed the wrong queue. 
 
You can easily add the wrong image to the queue, especially when 
adding images from the Clipboard or Scrapbook.  Use the 
MacRascol Queue Builder Cropping command to make sure 
you’ve added the correct image to the queue. 
 
To avoid processing the wrong queue, always check the bottom line 
in the MacRascol Print Monitor window.  It lists the name of the 
queue being processed.  If it doesn’t list the queue you want to 
process, choose Open Image Queue from the File menu and open 
the queue you want to process.  If the queue name is correct, make 
sure you aren’t working with a different queue by the same name. 
 
 

The image is too small or 
cut off_ 

The image was not cropped properly. 
 
If the image is too small, adjust the cropping frame to include as 
little background as possible.  This is especially problematic with 
bitmap images.  Some applications create an 8" x 10" image file 
regardless of the size of the graphic. 
 
If the image is cut off, adjust the cropping frame so that the entire 
image fits within the frame. 
 
 

The background doesn’t 
appear 

The image takes up the entire frame and hides the background.  
This is a problem with the application that generated the image. 
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Text alignment doesn’t 
match the original 

This happens when Fine Character Spacing in MacRascol Queue 
Builder is set incorrectly for the image. If the application you used to 
create the image specified fractional widths for the text, you should 
select the Fine Character Spacing option for that image.  You can 
double-check this by viewing the image in the Cropping window 
with Fine Character Spacing on and again with it off.  Set the 
option for whichever setting looks better.  Fine Character Spacing 
is described in the “Enhancing Images in a Queue” section of the 
Using MacRascol chapter. This can also happen when two different 
fonts with the same name are installed in the System. A common 
problem is having two Helvetica fonts installed, one from Apple and 
one from Adobe. 
 
 

Fonts don’t match the 
original 

The fonts that the image was created with are not installed on the 
computer that the PICT or Print file is being imaged with.  Install the 
missing fonts on the imaging computer, or translate the file into BLL 
file format on the creating computer. 
 

You are using ATM and 
getting blocky or missing 
characters 

ATM may not have enough memory to create the large characters 
needed for film recorder output.  Open the ATM control panel, and 
do the following: 
 
! Set ATM to On.  
! Set the Font Cache to at least 64K. 

! Select Preserve Character Shapes. 

 
 

Text looks jagged Screen fonts were used instead of the high-resolution scalable 
fonts. 
 
To avoid jagged fonts, use TrueType or ATM fonts. 
 
 

Few periodic faint 
horizontal lines 

For complex images MacRascol Print Monitor may not be able to 
send data to the film recorder fast enough. If you notice any periodic 
faint horizontal lines in the output that are not in the original image, 
try adjusting the exposure time using the Exposure Time attribute 
in MacRascol Queue Builder or MacRascol Chooser driver. Try 
setting the exposure time to 1 1/2 times the normal imaging time of 
the problem image. If this does not work, experiment with longer 
times. 
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Glossary 
 

 
active window    The front most window on the Macintosh desktop. 
 
antialiasing    Assigning pixels at the edges of objects a graduated 
gray scale of values. This dramatically reduces the appearance of 
jaggies. 
 
aspect ratio    The correspondence between the length and width of 
an image expressed as a ratio. The aspect ratio for a slide is 3:2. 
 
background    A color that is placed behind the image. When the 
image is output, the background shows through the areas of the 
image that were not drawn over in the graphics application. 
 
bitmap    A type of graphic composed of a rectangular group of 
colored dots. Bitmaps can have jagged edges when output at a 
different-resolution than they were created. Compare to object. 
 
bitmapped font    A font which is described as a bitmap (see above). 
Bitmapped fonts do not look good when used at high resolution 
because they have jagged edges. 
 
BLL    An abbreviation for Binary Lasergraphics Language. The BLL 
format serves as a machine independent graphics output format for 
use by Lasergraphics Rasterizers. If MacRascol is configured 
properly during installation, it can image BLL files generated by the 
WinBLL and WinRascol software on IBM PC compatibles running 
Windows. 
 
camera back    A film recorder’s camera. 
 
Chooser driver    A device driver which your Macintosh uses to 
output images when you select the Print command from the File 
menu. 
 
client Macintosh     The Macintosh where MacRascol software is 
sending images to the server Macintosh running MacRascol Server. 
 
clipboard    A temporary storage space for text or graphics. Use the 
Copy or Cut commands to place an image on the clipboard, and 
Paste to get it back. 
 
contrast    Measures the range of shades between light and dark. 
Black and white is high contrast, whereas two similar shades of gray 
is low contrast. 
 
crop    To trim an image prior to output. 
 
default preference    The preference that is automatically assigned 
to an image when you add that image to a queue. 
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desk accessory    A type of program which is usually installed into 
your System folder and appears in the Apple menu. 
 
directory    A folder. 
 
DPI    Dots per inch.  Commonly used to specify printer resolution. 
 
Finder    Program that is active when your Macintosh is first started.  
It allows you to open disks, folders, and documents, and launch 
applications. 
 
font    A typeface. 
 
HPGL    An abbreviation for Hewlett-Packard Graphics Language. 
 
landscape    An output orientation where the width is greater than the 
height.  Also known as horizontal or wide format.  Compare to 
portrait. 
 
Lasergraphics Language    A powerful graphics language that is 
common in the mainframe and minicomputer environments and 
Harvard Graphics for DOS. 
 
LFR    Lasergraphics Film Recorder.  Refers to a family of film 
recorders including the Personal LFR, Personal LFR Plus, LFR-X, 
LFR-X95, LFR Mark II, LFR Mark II Digital Photography Model, LFR 
Mark III, LFR Mark III Digital Photography Model, LFR Mark V Digital 
Photography Model, and LFR Mark VI Digital Photography Model. 
 
LL    An abbreviation for Lasergraphics Language. 
 
memory    See virtual memory and real memory. 
 
object    A type of graphic composed of graphic primitives (e.g., 
circles, lines, polygons, etc.). The graphic primitives are represented 
by their mathematical coordinates. Objects reproduce well at high 
resolution. Compare to bitmap. 
 
output device    A film recorder or color printer. 
 
output    To create an image on a film recorder or color printer. 
 
pattern    A repeating group of items, usually dots. 
 
PICT    The standard Macintosh picture format. 
 
pixel    An acronym for picture element. A pixel is a single dot on your 
monitor or output device. 
 
portrait    An output orientation where the height is greater than the 
width.  Also known as vertical or tall format. Compare to landscape. 
 
preference    A preference contains all of the processing options for 
output on film. 
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Print    A type of image file that is created by a MacRascol Chooser 
driver when you use the Print… command from an application to 
output pages. 
 
Print Queue    A special queue which you can manipulate like other 
queues, but which MacRascol Print Monitor treats specially. When 
MacRascol Print Monitor runs in the background, it will immediately 
process any image that appears in the Print Queue. Images are 
deleted from the Print Queue once they have been successfully 
completed. 
 
process    To use MacRascol Print Monitor to output images on 
either an LFR or color printer. 
 
queue    A list of images grouped together for enhancement and 
processing. 
 
raster    See bitmap. 
 
real memory    Actual physical memory in the form of chips in your 
computer. Compare to virtual memory. 
 
resolution    The total number of dots in an image. Film recorder 
resolutions measured in lines represents the number of dots across 
the image.  
 
RGB    Red Green Blue.  The color model used by monitors and film 
recorders. By combining red, green, and blue light, any color can be 
produced. 
 
RISC    Reduced Instruction Set Computer. This technology is used 
in the Lasergraphics RISC Rascol rasterizing co-processor. 
 
scalable font    A type of font that reproduces well at any size and 
resolution. 
 
scrap or scrapbook     A desk accessory to which you can copy or 
paste text or graphics. Some applications allow you to save groups of 
images into a scrapbook.  MacRascol Queue Builder allows you to 
place all PICT images of a scrapbook into a queue. 
 
SCSI    Small Computer System Interface. Your Macintosh uses 
SCSI technology in its SCSI bus, which you can daisy chain up to 7 
devices including your LFR. 
 
server Macintosh     The Macintosh where MacRascol Server is 
running. 
 
system font     A font which is displayed on your computer screen.  
System fonts can be either bitmapped or scalable. 
 
virtual memory    Extended “memory” for your computer provided by 
using your hard disk to hold portions of programs and data that are 
not currently in use. Virtual memory makes your computer appear to 
have more available memory than it really has. Compare to real 
memory. 
 
volume    A disk mounted in the Finder. 



182           Glossary 

 
 
 



 183 

Index 
 

 
24-bit color........................................................3 
35mm prints .......................................................2 
35mm slides.......................................................2 
Add Image........................................................53 
Add Many.........................................................54 
Add one............................................................56 
Add the copy ..................................................51 
adding images to queues...........................33, 51 

from Clipboard ................................................... 55 
from drags........................................................... 55 
from files ...................................................... 53, 54 
from Scrapbook .................................................. 56 
problems ........................................................... 172 

Additional Scaling ..................................126, 152 
Adobe Photoshop™...........................................3 
Antialiasing.....................................................113 
AntiAliasing ....................................................145 
AppleTalk LFR..............................2, 18, 36, 104 
applications 

draw...................................................................... 8 
paint ...................................................................... 8 

ATM 
blocky or missing letters................................... 177 

ATM Fonts 
using ................................................................... 80 

attribute values...............................................143 
Attributes menu..............................................138 
background ......................................................5 

problems ........................................................... 176 
Background ..................................148, 149, 152 
Background Color ..........................................125 
Best fit ....................................................125, 152 
bitmaps .......................................................8, 82 
Black & White.................................................148 
Blend Patterns..............................................148 
BLL file 

defined .................................................................. 3 
making ................................................................ 84 

BLL File...................................2, 18, 36, 38, 108 
brightness ........................................................71 
Brightness ......................................................71 
Brightness ............................................115, 147 
camera back 

missing or wrong .............................................. 173 
Camera Options ...........................................113 

using ............................................................. 26, 28 
Character Spacing .........................................148 
Chooser 

using with MacRascol........................... 23, 36, 38 
Chooser Driver...............................................166 

Clipboard......................................................3, 10 
adding images from ............................................ 55 

clipping.........................................................3, 10 
color 

fidelity................................................................... 7 
problems with ................................................... 172 
true color............................................................... 3 

color balance .....................................................5 
Color Balance ........................................114, 115 
Color Balance & Gamma.................72, 73, 146 
Contrast Gamma ..................................115, 147 
Copies............................................................144 
Copies Done ..................................................141 
Copies Waiting...............................................141 
creating new queues........................................32 
Crop edges ............................................125, 152 
cropping .............................................................5 

an image.............................................................. 79 
cannot magnify ................................................. 171 
colors look different.......................................... 172 
constrained.................................................. 79, 153 
Default ........................................................ 79, 154 
image is blank ................................................... 171 
magnify ............................................................. 154 
Magnify .............................................................. 79 
reduce................................................................ 154 
Reduce ................................................................ 79 
selection rectangle............................................... 79 
Update............................................................... 154 

Cropping ........................................................149 
Cropping [command] .......................................79 
cropping window .........................148, 149, 150 
Cropping window ...........................................153 
Default Cropping..........................................150 
Default Preferences .........................................63 
deleting 

images ................................................................. 59 
preferences.......................................................... 67 

Device not ready............................................173 
Dicomed Tile ................................................3, 10 
DIP switch ........................................................15 
DOS compatible.................................................4 
DOS filenames .............................................109 
Dragging Image Files.....................................128 
Dropbox menu ...............................................123 
Dropbox Operation ..........................................96 
Dropbox Setup.................................................95 
Edit menu.......................................................133 
e-mail .............................................................170 
enhancing 



 

184           Index 

bitmaps................................................................ 82 
object images ...................................................... 82 

error messages 
displaying in MacRascol Queue Builder............. 94 
from MacRascol Print Monitor ......................... 173 

Exposure Time...............................................113 
File menu ...............................120, 131, 158, 164 
Film Recorder ......................70, 72, 73, 144, 166 

AntiAliasing ....................................................... 68 
bitmaps................................................................ 82 
Color Balance ............................................ 71, 115 
Color Balance and Gamma .............................. 68 
Exposure Time .................................................. 113 
Minimum Exposure Time ................................ 68 
objects ................................................................. 83 
problems............................................................ 174 
Resolution ......................................................... 113 
Resolutions........................................................ 166 
running out of film............................................ 173 

Film Type ........................................68, 113, 144 
Fine Character Spacing 

problems with ................................................... 177 
whether or not to use........................................... 81 

fonts 
don’t match original .......................................... 177 

gamma ...............................................................5 
Gamma ............................................................71 
hardware 

required ............................................................... 13 
supported........................................................... 166 

Header Image ................................................101 
Hewlett-Packard Graphics Language ............3 
horizontal lines ...............................................177 
IBM® PC.....................................................3, 109 
image 

deleting................................................................ 59 
is blank.............................................................. 176 
is small or cut off .............................................. 176 
orientation of....................................................... 74 
reordering............................................................ 58 
selecting .............................................................. 57 
setting status of ............................................. 60, 61 
unable to open................................................... 174 
unwanted horiz. lines ........................................ 177 
wrong ones output............................................. 176 

image problems .............................................175 
image quality 

and film recorders ............................................... 68 
setting.................................................................. 68 

image queue ....................................................31 
defined ................................................................ 10 
how they work .................................................... 10 

Image Type ....................................................143 
images 

adding to a queue ................................................ 51 
cropping .............................................................. 79 
enhancing ............................................................ 80 

Images Left 

shows zero.........................................................175 
Images menu .................................................135 
Inactive.............................................................97 
Installation........................................................16 
Lasergraphics Language ................................3 
Lasergraphics Language ...............................168 
Lasergraphics web site ..................................170 
LFR ....................................................................2 
LFR Mac/PC Harmony ...................................19 
LFR Server ....................................2, 18, 36, 104 
MacRascol 

about......................................................................2 
configuring ....................................................23, 36 
enhancement tools .................................................5 
one-step printing..................................................30 
Print window....................................................117 
printer driver..........................................................3 
printing ................................................................25 
quick printing ......................................................27 
tutorial .................................................................22 

MacRascol Chooser driver ..........................2, 23 
images with jaggies ...........................................171 
miniature images ...............................................171 

MacRascol Chooser Driver 
problems............................................................171 

MacRascol Print Monitor.................................2 
errors .................................................................173 
menus ................................................................158 
problems............................................................175 
status messages..................................................156 
window......................................................156, 162 

MacRascol Queue Builder ............................18 
displaying errors..................................................94 
menus ................................................................130 
monitor processing ..............................................94 
problems............................................................172 

MacRascol Queue Builder ..............................2 
MacRascol Quick Print ............................18, 27 

using ....................................................................95 
MacRascol Quick Print ....................................2 
MacRascol ReadMe .......................................18 
MacRascol Server............................2, 12, 18, 36 

Header Image ....................................................101 
Launching............................................................99 
menus ................................................................164 
Operation.............................................................97 
options...............................................................164 
Reservations ......................................................100 
terminology .........................................................97 
using ....................................................................97 

MacRascolQ Data folder ...............................18 
mainframes ........................................................3 
Match pixels ...........................................126, 152 
memory 

and processing speed.........................................169 
Memory Requirements........................................89 
problems............................................................173 
RAM cache........................................................169 



 Appendix D – Troubleshooting                185 

Memory Requirements ....................................89 
minicomputers....................................................3 
Minimum Exposure Time ..............70, 113, 145 
Native Resolution.............................................76 
objects ..................................................8, 82, 84 
Orientation .....................................................149 
Page Setup ...................................................111 

Background Color .................................... 112, 121 
Blend Patterns............................. 41, 43, 111, 121 
Camera Options.......................................... 42, 43 
Color Balance.............................................. 42, 43 
Fine Character Spacing............................... 43, 120 
Invert Black and White .............. 41, 43, 112, 121 
Native Resolution...................................... 41, 111 
Orientation................................................ 111, 120 
parameters .................................................... 41, 43 
Pen Colors .......................................................... 43 
Raster Scaling..................................................... 43 
Reduce or Enlarge ............................................ 111 
Save as Default ................................................. 112 
using ............................................................. 25, 27 

page size 
Reduce or Enlarge .............................................. 76 

Patterns..........................................................147 
Pen Colors .............................................127, 150 
Pen Thickness .......................................127, 150 
PICT.................................................................10 

defined .................................................................. 3 
pixel aspect ratio ........................................77, 78 
Pixel Height 

Pixel Width............................................... 125, 151 
Plotter Model..........................................127, 150 
preference 

changing ....................................................... 64, 65 
creating ......................................................... 63, 66 
creating default ................................................... 63 
deleting ............................................................... 67 

preferences.......................................................5 
Default ............................................................... 62 
opening ............................................................. 132 

Preferences..............................................62, 143 
Print command..............................................117 
Print Files window 

using ................................................................... 28 
print queue 

opening ............................................................. 132 
Print Queue 

opening ............................................................... 50 
requirements ....................................................... 92 
starting ........................................................ 92, 158 

Print Queue......................................................92 
Print window 

using ................................................................... 26 
Print Window....................................................45 

selecting a queue................................................. 46 
printer 

unable to access ................................................ 171 
printer driver.....................................................23 

printing images ................................................40 
PrintMe............................................................18 
Process Print Queue......................................158 
processing 

is very slow....................................................... 175 
speeding up ....................................................... 169 

processing options.........................................143 
processing queues...........................................33 
PSD....................................................................3 
queue 

creating ....................................................... 48, 131 
defined .................................................................. 2 
defined .............................................................. 129 
grouping images into ...................................... 5, 31 
grouping images into .......................................... 47 
opening ............................................... 49, 132, 158 
printing images into .............................................. 5 
processing ........................................................... 88 
selecting .............................................................. 48 
unable to access ................................................ 172 

Raster Scale ............................................78, 151 
Raster Scaling .........................................77, 125 
Reservations..................................................100 
resolution 

defined .................................................................. 6 
image resolution .................................................. 2 

Resolution ......................................................144 
RISC Program 

not compatible .................................................. 174 
unable to find .................................................... 174 
unable to send ................................................... 174 

sample PICT ....................................................22 
Sample PICT ...................................................18 
Save as Default ..............................................42 
Scrapbook....................................................3, 10 

adding images from ............................................ 56 
SCSI ID number...............................................15 
SCSI LFR.......................................2, 18, 36, 104 
serial key..........................................................17 
Serving Client ..................................................98 
Skip All ...........................................................159 
slide 

2000-line ............................................................... 7 
4000-line ............................................................... 7 
8000-line ............................................................... 7 

Software Required ...........................................13 
Status.............................................................143 
Supported Camera Backs/Film Formats .......167 
Supported Film Types....................................167 
Supported Macintosh.....................................166 
Supported Output Devices.............................166 
Targa..................................................................3 
Targa,...............................................................10 
Technical Support.............................................. ii 
text 

alignment problems........................................... 177 
bitmaps.................................................................. 9 
looks jagged ...................................................... 177 



 

186           Index 

objects ................................................................... 9 
TGA....................................................................3 
TIF......................................................................3 
TIFF..............................................................3, 10 
Time Done .....................................................141 
Troubleshooting .............................................170 
TrueType Fonts 

using.................................................................... 81 
Unused Memory.............................................159 

not enough.........................................................173 
setting ..................................................................91 

Use DOS compatible filenames.....................109 
virtual memory .................................................90 
Waiting for Request ...................................98, 99 
Waiting for Request .......................................100 
Window menu ................................................138 
WinRascol........................................................17 

 


	Introduction
	Features
	Important Concepts
	How Image Queues Work
	MacRascol on a Network
	What You Need

	Installation
	Install Your Film Recorder
	Install the MacRascol Software

	Learning MacRascol
	Preparing for the Tutorial
	Configure MacRascol
	Print With MacRascol
	Quick Print
	One-step Printing
	Group Images into a Queue

	Using MacRascol
	All About Configuration Options
	Printing Images
	Grouping Images into a Queue
	Working with Preferences
	Setting Image Quality
	Cropping and Sizing Images
	Working with Specific Images
	Moving and Copying Queues
	Processing Queues for Output
	Dropbox Operation
	Server Operation

	MacRascol Chooser Driver Reference
	The Chooser
	The Page Setup Window
	The Print Window

	MacRascol Quick Print Reference
	Menus and Commands
	Finder Operation

	MacRascol Queue Builder Reference
	Menus and Commands
	The Preferences Window
	Image Queue Windows
	Processing Options
	The Cropping Window

	MacRascol Print Monitor Reference
	The MacRascol Print Monitor Window
	Menus and Commands

	MacRascol Server Reference
	The MacRascol Server Window
	Menus and Commands

	Appendices
	Appendix A – Specifications
	Appendix B – Using LL Images
	Appendix C – Speeding Up Processing
	Appendix D – Troubleshooting

	Glossary
	Index

